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MotionBuilder チュートリ
アル

本書には、9 つの Autodesk MotionBuilder チュートリアルのセットが含まれています。これら
のチュートリアルでは、一般的な MotionBuilder ワークフローについて説明し、さらに強力に
なったキーフレームとキャラクタアニメーション機能の使い方を紹介します。

チュートリアル用のアセットは、Asset Browser の Tutorials フォルダ(またはシステム上の
MotionBuilder ディレクトリ内の Tutorials フォルダ)にあります。

注: Asset Browser が表示されていない場合は、MotionBuilder メニューバーから
Window > Asset Browser を選択します。

注: Asset Browser に Tutorials フォルダが表示されない場合は、対応するディレクトリ
のパスをよく使用するパスとして追加する必要があります。

Asset Browser に表示するディレクトリを追加するには:

■ MotionBuilder のヘルプの「よく使用するパスを追加する」の手順または『ユーザガイド』
の「MotionBuilder インタフェース」の「Asset Browser」を参照してください。

以下のようなチュートリアルがあります。

■ キャラクタモデルをロードし、キャラクタライズする (7 ページ)

■ コントロールリグを作成し、カスタマイズする (19 ページ)

■ キャラクタエクステンションを作成する (33 ページ)

■ 歩行サイクルを作成する (47 ページ)

■ キャラクタアニメーションをリターゲットする (65 ページ)

■ キャラクタアニメーションを編集する (77 ページ)

1
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■ ループを作成する (91 ページ)

■ クリップを操作する (107 ページ)

■ MotionBuilder に 3ds Max ファイルをインポートする (119 ページ)

関連事項:

■ MotionBuilder ワークフロー (2 ページ)

注: チュートリアル用のアセット(サポートファイル)は、
http://www.autodesk.co.jp/motionbuilder-documentation からダウンロードできます。

最新の FBX Plug-in をインストールする
Autodesk® FBX® テクノロジは、最も幅広く使用され、サポートされているプ
ラットフォームに依存しない 3D データ交換ソリューションの 1 つです。
Autodesk FBX で広範囲に 3D アセットを交換することで、データ互換性の障害
が取り除かれ、プロジェクトの効率を向上させるパイプラインをより自由に構築
することができます。

Autodesk FBX は、複数のオートデスク製品間での相互運用性を促進します。
MotionBuilder が FBX をネイティブでサポートしていることに加え、Autodesk®

Maya® と Autodesk® 3ds Max® ソフトウェアには FBX プラグインが付属して
います。さらに、Autodesk® Softimage® ソフトウェアでは、Autodesk®

Crosswalk を利用して FBX ファイルを読み書きできます。また、Autodesk ®

Mudbox ™ 2010 は、Mudbox では初めて FBX をサポートしており、Mudbox、
Maya、3ds Max、MotionBuilder 間のワークフローの統一が一層強化されてい
ます。

最新の FBX プラグインとそのドキュメントは、http://www.autodesk.co.jp/fbx か
らダウンロードできます。

MotionBuilder ワークフロー
ここでは 9 つのチュートリアルで MotionBuilder の一般的なワークフローを説
明します。これらのチュートリアルを活用して、MotionBuilder に慣れてくだ

2 | 第 1 章 MotionBuilder チュートリアル
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さい。ワークフローの手順の中で、専用のチュートリアルがついていないものの
詳細については、MotionBuilder ヘルプを参照してください。

チュートリアルでは、キャラクタアニメーションプロジェクトのために
MotionBuilder を使用していることを前提にしていますが、このワークフロー
は、他の 3D モデリングやレンダリングソフトウェアと連動して MotionBuilder
を使用しているアニメーションプロジェクトであればどれにでも簡単に応用で
きます。

MotionBuilder を使用するための基本的なワークフローを要約すると、次のよ
うになります。

1 作成データを他の 3D ソフトウェアパッケージから MotionBuilder へ、も
しくは MotionBuilder から転送できるようにするために、必須の FBX
Plug-in をインストールします。

たとえば、Maya または 3ds Max を使用してキャラクタモデリングを行う
場合、適切な Maya または 3ds Max FBX プラグインをインストールし、作
成したモデルを MotionBuilder に転送する必要があります。最新の FBX
Plug-in をインストールする (2 ページ)を参照してください。

2 任意の 3D モデリングソフトウェアで、キャラクタモデルを作成します。

モデリングの段階でいくつかのことに注意しておけば、その後の
MotionBuilder でのアニメーションプロジェクトの作業がスムーズになり
ます。

このヘルプの「キャラクタモデルの作成のガイドライン」、「ボーン命名
規則」、「3ds Max の Biped を MotionBuilder にインポートしてキャラク
タライズする」、「作成するシェイプを選択する」を参照してください。

3 モデリングソフトウェアパッケージからキャラクタモデルをエクスポート
します。

モデリングソフトウェアパッケージから作品をエクスポートする場合、イ
ンストールした FBX Plug-in により、キャラクタモデルを .fbx ファイル
フォーマットで保存することができます。このフォーマットを使用すれば、
MotionBuilder にモデルをロードできます。

4 MotionBuilder を起動し、キャラクタモデルをロードします。

モデルを MotionBuilder にロードしたら、MotionBuilder Character アセッ
トを使用して、このモデルがアニメートされるようにセットアップできま
す。

MotionBuilder ワークフロー | 3



5 キャラクタモデルに Character アセットを追加し、キャラクタライズしま
す。

Character アセットを使用すると、キャラクタモデルの構造をマップ化し
て、MotionBuilder でアニメーション化するのに役立ちます。このマッピ
ングプロセスを完了したら、キャラクタモデルをキャラクタライズして、
アクティブ化します。キャラクタライズにより、このキャラクタモデルを
アニメーションにする準備が整ったことが MotionBuilder に伝えられます。

コントロールリグや Story ウィンドウでのアニメートを含め、
MotionBuilder の主要なキャラクタアニメーション機能すべてで、キャラ
クタライズされたキャラクタが必要です。

最初のチュートリアルでは、Character アセットの作り方と、これを使用し
て、キャラクタモデルの構造をマップ化する方法について説明します。

キャラクタ モデルをロードし、キャラクタライズする (7 ページ)を参照し
てください。

6 コントロールリグを追加し、キャラクタアニメーションでの必要に応じ
て、カスタマイズします。

コントロールリグはキャラクタモデルの制御や配置をしやすくするための
アニメーションツールです。

2 つ目のチュートリアルでは、コントロールリグのカスタマイズ方法、お
よび床の接触や Auxiliary ピボットなどのキャラクタアニメーション機能
の追加方法について説明します。

コントロールリグを作成し、カスタマイズする(19ページ)を参照してくだ
さい。

7 プロップ(小道具)や人間以外の身体部分をサポートするために、キャラクタ
エクステンションを追加します。

3 つ目のチュートリアルでは、余分な手足を持つキャラクタを追加する方法
について説明します。この例では、キャラクタの右肩に、大きなハサミの
付いた「サーボアーム」を追加します。

キャラクタエクステンションを作成する(33ページ)を参照してください。

8 いろいろなキーフレーム設定やキャラクタアニメーション機能を使用して、
アニメーションを作成します。
■ アニメーションを作成するための効率的な手法の 1 つとして、いろいろ

な時点で、キャラクタにペーストできるポーズのセットを作成すること
ができます。
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4 つ目のチュートリアルでは、コントロールリグと Pose Control を使
用して、歩行サイクルを作成する方法を説明します。

歩行サイクルを作成する (47 ページ)を参照してください。

■ 7 つ目のチュートリアルでは、Story ウィンドウでクリップを使用して、
歩行サイクルを作成する方法について説明します。
ループを作成する (91 ページ)を参照してください。

9 アニメーションを編集し、微調整します。
■ 6 つ目のチュートリアルでは、レイヤを使用して、アニメーションを編

集する方法について説明します。
キャラクタアニメーションを編集する(77ページ)を参照してください。

■ 8 つ目のチュートリアルでは、Story ウィンドウを使用してアニメーショ
ンを結合する方法について説明します。
クリップを操作する (107 ページ)を参照してください。

10 Character モデル同士の間で、アニメーションを再ターゲットします。

アニメーションプロジェクトの途中で、キャラクタモデルが変更されるこ
ともあり得ます。MotionBuilder でのアニメーション作成に必須の手順で
はありませんが、新しいモデルでアニメーションを作成し直すのではなく、
単純に同じアニメーションを別のモデルに適用することも可能です。

5 つ目のチュートリアルでは、キャラクタモデルどうしの間で、アニメー
ションとキャラクタエクステンションを転送する方法について説明します。

キャラクタアニメーションをリターゲットする(65ページ)を参照してくだ
さい。

11 完成したアニメーションをモデルのスケルトンにプロットします。

キャラクタアニメーションの作成に使用しているアニメーション機能によっ
ては、コントロールリグからキャラクタモデルスケルトンへのプロット作
業や、Story ウィンドウのトラックをシングルテイクにプロットする作業
が行われます。

アニメーション化に使用される方法が何であれ、エクスポート前に、完成
した結果をキャラクタモデルのスケルトンにプロットする必要があります。

「アニメーションをプロットする」の「プロットプロセス」を参照してく
ださい。

12 プロットしたモデルを .fbx ファイルとして保存します。
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完成したアニメーションは、任意のソフトウェアでレンダリングできるよ
うに、適切な FBX Plug-In を使用してエクスポートすることもできます。

最新の FBX Plug-ins は、http://www.autodesk.co.jp/fbxからダウンロードで
きます。

13 MotionBuilder で 3ds Max キャラクタをアニメートした後、そのアニメー
ションを 3ds Max で使用するには、3ds Max シーンを MotionBuilder に
インポートし、MotionBuilder でアニメートした後、3ds Max にアニメー
ションをインポートする必要があります。

最後のチュートリアルでは、MotionBuilder にアニメーションをインポー
トし、MotionBuilder でアニメートし、MotionBuilder からアニメーショ
ンをエクスポートし、それを 3ds Max にインポートする主な手順について
説明します。

3ds Max のスケルトン (121 ページ)、3ds Max の Biped (135 ページ)、3ds
Max のキャラクタ (145 ページ)、3ds Max のキャラクタを MotionBuilder
でアニメートする (153 ページ)、キャラクタをエクスポートしてアニメー
ションを 3ds Max にインポートし直す (166 ページ)を参照してください。
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キャラクタモデルをロー
ドし、キャラクタライズ
する

このチュートリアルでは、キャラクタモデルを MotionBuilder に取り込み、アニメーションに
するための準備の手順について説明します。

コントロールリグを作成し、ポーズを作成し、その他のアニメーションツールを使用するには、
MotionBuilder に取り込んだキャラクタモデルをキャラクタライズする必要があります。キャ
ラクタモデルをキャラクタライズするには、モデルの構造をマッピングする必要があります。

このチュートリアルの主な項目は次のとおりです。

■ シーンを準備する (8 ページ)

■ キャラクタマップを仕上げる (9 ページ)

■ キャラクタモデルをキャラクタライズする (15 ページ)

このチュートリアルで使用するアセット:

■ mia_blue.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorials フォルダ(またはシステ
ム上の MotionBuilder ディレクトリ内の Tutorials フォルダ)にあります。
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シーンを準備する
次の手順では、MotionBuilder シーンを準備し、このチュートリアルを開始す
るのに必要なファイルを開きます。

1 メニューバーから File > New を選択し、Layout > Editing を選択します
(Ctrl+Shift+3 キー)。

MotionBuilder は、新規 3D シーンを Editing レイアウトで表示します。
このレイアウトには、このチュートリアルで作業するのに必要なすべての
ウィンドウが表示されます。

2 Asset Browser で Tutorials フォルダをクリックします。

3 mia_blueアセット(mia_blue.fbxファイル)を Asset Browser から Viewer ウィ
ンドウへドラッグし、FBX Open > No Animation を選択します(図を参照)。

Viewer ウィンドウに、Mia という名前のモデルが T-スタンスで表示されま
す。
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T-スタンスの Mia

注: このモデルは Maya で作成されたもので、ボーンには MotionBuilder
のマッピングリストにある命名規則に従って名前が付けられています。

キャラクタマップを仕上げる
次の手順では、マッピングリスト内で必要なノードをマッピングして、
MotionBuilder のキャラクタモデルの構造を定義します。キャラクタマッピン
グは、MotionBuilder に対してキャラクタモデルを記述する作業で、何が足で
何が腕にあたるかといったことを指示していきます。

Character アセットを直接、キャラクタモデルにドラッグしてキャラクタのマッ
ピングとキャラクタライズを自動で処理することもできますが、このチュートリ
アルでは Mia の構造を手動でマッピングします。

1 Asset Browser の Templates > Characters フォルダから、シーンの空の領域
に Character アセットをドラッグします。
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Character アセットが Scene Browser に追加され(A)、Navigator ウィンド
ウに Character Settings が表示されます(B)。

Navigator ウィンドウ: A. Scene Browser のキャラクタ B. Character
Settings

2 Character Settings で Character Definition ペインに切り替えて、マッピ
ングリストでノードの Base (required)グループを展開します(A)。
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Character Definition ペイン:  A. Base ノード

このノードグループは、MotionBuilder がキャラクタモデルの構造を認識
するための必須のグループです。キャラクタを自動的にキャラクタライズ
したとすると、マッピングリストにはキャラクタのボーン名が自動的に入
力されます。

3 Viewer ウィンドウで、Schematic ビューに切り替え(Ctrl+W キー)、A キー
を押して、階層をフレームします。

Mia 構造の Schematic ビュー

Schematic ビューを使用すると、各ボーンが長方形のノードとして表され
るので、モデルの階層からボーンを選択しやすくなります。
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4 Scene Browser で Lock オプションを有効にして、Character Definition ペ
インのビューをロックします。こうすると、何を選択しても Character
Definition ペインが開いたままになります。

Navigator ウィンドウ: A. Scene Browser Lock オプションがオン

5 Schematic ビューで、ズームイン(Ctrl キーを押しながらドラッグ)して
Mia:LeftUpLeg ノードを選択します。

Mia:LeftUpLeg ノードが選択された状態

注: Schematic ビューで選択したいノードの正確な名前が分かっている場合
は、Shift+N キーを押して Find Model by Name ダイアログボックスを開
き、ノードをすばやく検索できます。
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6 Mia:LeftUpLeg ノードを Base (required)の LeftUpLeg のマッピングリストス
ロットへ、Alt キーを押しながらドラッグします。

MotionBuilder の LeftUpLeg にマッピングされた Mia の LeftUpLeg ノード

このキャラクタをキャラクタライズすると、MotionBuilder は、このスケ
ルトンについては LeftUpLegノードを "Mia:LeftUpLeg"と呼ぶと認識します。

7 次のチェックリストと図をガイドとして使用し、残りの Mia ボーンを、
マッピングリストの Base (必須)ノードにマップします。

注: Mia には多くのボーンがありますが、MotionBuilder のキャラクタラ
イズでは、15 個の Base グループをマップする必要があるだけです。

マップ済みスロットボーン

HipsMia:Hips

XLeftUpLegMia:LeftUpLeg

LeftLegMia:LeftLeg

LeftFootMia:LeftFoot

RightUpLegMia:RightUpLeg
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マップ済みスロットボーン

RightLegMia:RightLeg

RightFootMia:RightFoot

SpineMia:Spine

LeftArmMia:LeftArm

LeftForeArmMia:LeftForeArm

LeftHandMia:LeftHand

RightArmMia:RightArm

RightForeArmMia:RightForeArm

RightHandMia:RightHand

HeadMia:Head

Base グループのキャラクタマッピングが完了すると、マッピングリスト
は次の図のようになります。

Mia の Base ボーンをマッピング リストの Base ノードにマッピン
グした状態
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これでキャラクタマッピングは完了です。

キャラクタモデルをキャラクタライズする
次の手順では、モデルをキャラクタライズする方法について説明します。キャラ
クタモデルをキャラクタライズすると、マッピングリストで定義した構造が
MotionBuilder により読み取られ、モデルの現在のポーズが以降のすべてのポー
ズと動きのベースになると解釈されます。

1 Character Definition ペインで、Characterize オプションを有効にします
(A)。

Character Definition ペイン: A. Characterize オプション

2 表示される Character ダイアログボックスで Biped をクリックします(A)。
これは、Mia スケルトンが 2 本脚で立ち、足だけでフロア(床面)と接触する
ためです。
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Character ダイアログ ボックス: A. Biped オプ
ション

キャラクタがすべてのソースと互換性を持ち、キャラクタがキャラクタラ
イズされ、MotionBuilder がその構造を認識するように汎用のオフセット
が計算されます。

マッピングリストのノードはグレーになり、編集できません。

注: 後でボーンを追加したり、マッピングリストを編集したりする必要が
ある場合は、キャラクタが T-スタンスであるときに、Characterize オプショ
ンを一時的に無効にします。

3 Scene Browser で、Character ブランチを展開し、Character アセットを右
クリックし、コンテキストメニューから Rename を選択して、キャラクタ
に "Mia" という名前を付けます(A)。
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Scene Browser: A. Character アセットに Mia という名
前を付けます。

キャラクタは完全にキャラクタライズされ、アニメートする準備が整いま
した。

まとめ

このチュートリアルでは、キャラクタモデルをロードし、その構造をマップ化
して、キャラクタライズしました。

次のチュートリアル、コントロールリグを作成し、カスタマイズする (19 ペー
ジ)では、キャラクタライズしたキャラクタのためにコントロールリグを作成
し、カスタマイズします。
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コントロールリグを作成
し、カスタマイズする

このチュートリアルでは、コントロールリグを作成し、後のチュートリアルでアニメーションを
作成するために、このコントロールリグをカスタマイズする方法について説明します。

コントロールリグはキャラクタモデルの制御や配置をしやすくするためのアニメーションツー
ルです。コントロールリグは他のモデルに再利用することができます。

このチュートリアルの主な項目は次のとおりです。

■ シーンを準備する (20 ページ)

■ コントロールリグを作成する (20 ページ)

■ 足のフロアコンタクトマーカを調整する (24 ページ)

■ 手とフロアコンタクトマーカを調整する (27 ページ)

■ Auxiliary ピボットを追加する (28 ページ)

このチュートリアルで使用するアセット:

■ mia_characterized.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorials フォルダ(またはシステ
ム上の MotionBuilder ディレクトリ内の Tutorials フォルダ)にあります。
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シーンを準備する
次の手順では、MotionBuilder シーンを準備し、このチュートリアルを開始す
るのに必要なファイルを開きます。

1 メニューバーから File > New を選択し、Layout > Editing を選択します
(Ctrl+Shift+3 キー)。

MotionBuilder は、新規 3D シーンを Editing レイアウトで表示します。
このレイアウトには、このチュートリアルで作業するのに必要なすべての
ウィンドウが表示されます。

2 Asset Browser で Tutorials フォルダをクリックします。

3 mia_characterizedアセット(mia_characterized.fbxファイル)を Asset Browser
から Viewer ウィンドウへドラッグし(図を参照)、FBX Open > No Animation
を選択します。

T-スタンスの Mia

Viewer ウィンドウに Mia という名前のモデルが T-スタンスで表示されま
す。

コントロールリグを作成する
次の手順では、Mia キャラクタのコントロールリグを作成および準備します。
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1 Scene Browser で Characters ブランチを展開し、Mia キャラクタをダブル
クリックします。

2 Character Definition ペイン(A)をクリックし、Control Rig 領域(B)で Create
をクリックします。

Character Definition: A. 設定 B. Control Rig 領域

3 表示された Create Control Rig ダイアログボックスで、FK/IK を選択しま
す(A)。

Create Control Rig ダイアログボックス: A. FK/IK オ
プション

Mia キャラクタ用に FK/IK コントロールリグが作成されます。

4 Character Controls ウィンドウで Character Controls をクリックし、Ctrl
Rig In オプションをオンにします。これにより、コントロールリグが Mia
キャラクタのアクティブなモーションソースになります。
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Character Controls: A. Ctrl Rig In オプションがオンの
状態

5 Viewer ウィンドウをクリックし、X-Ray 表示モードになるまで Ctrl+Aキー
を押し続けます。

注: 表示モードは Viewer ウィンドウの左下に表示されます。

X-Ray 表示モードでは、コントロールリグを構成する FK エフェクタと IK
エフェクタを確認できます。青色と赤色の IK エフェクタでは、人間の体の
動きをシミュレートする設定を使用して、直感的にキャラクタを操作でき
ます。黄色の FK エフェクタでは、個々のボディパーツを選択して微調整
できます。キャラクタの微調整を行う予定の場合は、FK エフェクタと IK
エフェクタの両方を使用してコントロールリグを作成します。

6 Character Controls ウィンドウで、Show メニューを開き(A)、Skeleton オ
プションを無効にします。

キャラクタのスケルトンが非表示になり、Viewer ウィンドウのコントロー
ルリグの FK エフェクタと IK エフェクタが見やすくなります(B)。
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A. Skeleton オプションをオフ B. Mia キャラクタにコントロール リグが表示
されます。

7 Navigator ウィンドウで Character Settings ペインに切り替えます(B)。

Character Settings ペイン: A. Input Type メニュー B. Active オプションがオンの
状態

コントロールリグは、Character Settings ペインの Input Type メニューお
よび Active オプションでも、アクティブなモーションソースとして表示さ
れます(A および B)。
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足のフロアコンタクトマーカを調整する
次の手順では、フロアコンタクトマーカを使用して、キャラクタの足がどのよ
うにフロア(床面)に接触するかを調整します。

フロアコンタクトマーカは、キャラクタモデルをキャラクタライズするとキャ
ラクタの手と足の周囲に表示される青色と緑色のマーカです。これらのマーカ
は、キャラクタの足がフロアと接触する場所を決める不可視のグリッドを作成し
ます。

Character Definition ペインのマッピングリストでフロアオブジェクトが定義
されていない場合、MotionBuilder のグリッドがフロアとして使用されます。
このチュートリアルでは、フロアは定義しません。

1 Character Controls ウィンドウの Show メニューで Floor Contact がアク
ティブであることを確認します(A)。

Character Controls: A. Floor Contact がオンの状態

緑と青のフロアコンタクトマーカが、Mia の両手と両足の周囲に表示され
ます。

緑と青のフロアコンタクトマーカが、Mia の両手と両足の周囲に表示されます。
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2 Viewer ウィンドウで View メニューをクリックし、Orthographic > Producer
Right を選択して(または Viewer 内でクリックし、Ctrl+R キーを押して)、
Producer Right カメラビューに切り替えます。

3 Mia の足にズームインします(図を参照)。

4 Mia の足の下にあるフロアコンタクトマーカのいずれかをクリックしま
す。

5 Viewer ツールバーで Translate ボタンをクリック(T キー)して Translate
モードをアクティブにします。

6 フロアコンタクトマーカを移動します。次の説明と図を参考にして、マー
カの位置を合わせてください。
■ 中部のマーカをつま先のボーンが始まる場所に位置合わせします(B)。

■ 前部のマーカをモデルのつま先に位置合わせします(A)。

■ 後部のマーカをモデルのかかとに位置合わせします(C)。

Mia の足とフロアコンタクトマーカ: A. 前部のマーカ B. 中部のマーカ C. 後部
のマーカ
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注: 片方の足のマーカを移動すると、それに合わせてもう片足のマーカ
も調整されます(つまり、Mia の左足の緑のマーカを調整すると、右足
の青のマーカも自動的に調整されます)。

7 Orthographic Producer Front ビューに切り替えて(Ctrl+Fキー)、両足にズー
ムインして(Ctrl+ドラッグ)、足のマーカを左右に移動させて次の図のよう
に両足の端に配置します。

マーカの左および右の位置

8 Character Settings ペインで Floor Contacts (A)を展開し、Feet Floor Contact
オプション(B)をオンにします。

Character Settings ペイン: A. プロパティの Floor Contacts
グループ B. Feet Floor Contact オプション
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手とフロアコンタクトマーカを調整する
ここでは、Mia の手がフロア(床)に触れたときにリアルに反応するように、手の
フロアコンタクトを定義します。

1 Scene Browser で Mia キャラクタをダブルクリックし、Character Settings
ペインをクリックして Character Settings を表示します。

2 Character Settings ペインで、Floor Contacts (A)が展開されていない場合は
これを展開し、Hands Floor Contact (B)オプションと Fingers Floor Contact (C)
オプションをオンにして、手と指のフロアコンタクトを有効にします。

Character Settings ペイン:  A. Floor Contacts B. Hands Floor
Contact C. Fingers Floor Contact

3 Hands Floor Contact Setup を展開し、Hands Contact Type メニュー(A)をク
リックして Wrist を選択します。

Character Settings ペイン: A. Hands Contact Type B. Wrist

デフォルトでは Hands Contact Type は Normal に設定されており、手には
6 個のフロアコンタクトマーカが割り当てられます。このオプションを
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Wristに変更すると、それぞれの手に基本的な制御のための 4 個のフロアコ
ンタクトマーカが提供されます。

4 Viewer ウィンドウで各種カメラビューを使用して、Mia の左右どちらかの
手にズームインします。

5 手の後部のマーカを手首に、前部のマーカを指(親指以外)の付け根に位置合
わせします。さらに、次の図に示すように、後部のマーカを Y 軸に沿って
下へ移動して、手のひらの付け根に位置合わせします。

Auxiliary ピボットを追加する
次の手順では、Mia のコントロールリグにある IK システムをさらに詳細に制御
できるようにする 2 つの Auxiliary ピボットを作成します。これらの Auxiliary
オブジェクトを使用して、Mia の歩行に伴い、Mia の足にリアルな回転を作成
できます。また、これらのオブジェクトを使用すると、キーフレームアニメー
ションの作成時に Mia の足を回転しやすくなります。

1 Character Controls ウィンドウで、Left Ankle セルを右クリックし、コン
テキストメニューから Create Aux Pivot を選択します(A)。

Character Controls: A. Left Ankle エフェクタセルのコンテキストメニュー
オプション
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左足首の IK エフェクタに Auxiliary ピボットが作成されます(A)。Auxiliary
ピボットは、Character Controls ウィンドウの Left Ankle セルでは X 印で
示されます(B)。

A. Viewer ウィンドウの Auxiliary ピボット B. X 印が Auxiliary ピボット

デフォルトでは、Auxiliary ピボットを作成すると、足のエフェクタは選択
解除され、Auxiliary ピボットが選択されます。Viewer ウィンドウで、Pivot
Selection モードが自動的に選択されます。

Viewer ウィンドウ A. Pivot Selection モード

2 次の図のように作成した Auxiliary ピボットが選択されていない場合はこれ
を選択し、移動して Mia のつま先と重なる位置に配置します。
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左足首の Auxiliary ピボット A. 前面図 B. 側面図

注: Character Controls の Show メニューを使用して、Auxiliary ピボット
を配置するときにコントロールリグエフェクタとフロアコンタクトマー
カを非表示にすることができます。

3 Left Ankle セルをもう一度右クリックし、コンテキストメニューからCreate
Aux Pivot を選択します。

左足首に Auxiliary ピボットを作成し
ます。

Viewer ウィンドウに 2 つ目の Auxiliary ピボットが表示されます。

4 2 つ目の Auxiliary ピボットをかかとの位置に移動します(図を参照)。
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まとめ

このチュートリアルでは、コントロールリグを作成し、キャラクタの足にフロ
アコンタクトマーカを配置してから、足の回転を制御するために 2 つの Auxiliary
ピボットを作成しました。

次のチュートリアル、キャラクタエクステンションを作成する (33 ページ)で
は、Mia キャラクタに Character Extension を追加します。
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キャラクタエクステン
ションを作成する

このチュートリアルでは、キャラクタに追加された付属物を制御できるようにするためのキャラ
クタエクステンションの作成に必要な手順について説明します。

ここでは、Mia キャラクタの腕をロードし、キャラクタエクステンションを使用して腕を Mia
にアタッチしたら、胴体に対応して動く腕のアニメーションを定義します。

このチュートリアルの主な項目は次のとおりです。

■ シーンを準備する (33 ページ)

■ 追加した腕をキャラクタに接続する (35 ページ)

■ キャラクタエクステンションを作成する (40 ページ)

このチュートリアルで使用するアセット:

■ mia_rigged.fbx

■ servo.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorials フォルダ(またはシステ
ム上の MotionBuilder ディレクトリ内の Tutorials フォルダ)にあります。

シーンを準備する
以下の手順では、MotionBuilder シーンを準備し、このチュートリアルを開始す
るのに必要なファイルを開きます。

4
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1 メニューバーから File > New を選択し、Layout > Editing を選択します
(Ctrl+Shift+3 キー)。

MotionBuilder は、Editing レイアウトを使用して新しいシーンを表示しま
す。このレイアウトには、このチュートリアルで作業するのに必要なすべ
てのウィンドウが表示されます。

2 Asset Browser で Tutorials フォルダをクリックします。

3 mia_rigged アセット(mia_rigged.fbx ファイル)を Asset Browser から Viewer
ウィンドウへドラッグし、コンテキストメニューから FBX Open > No
Animation を選択します(図を参照)。

キャラクタライズされた Mia が Viewer ウィンドウに表示されます。

Viewer ウィンドウに Mia という名前のキャラクタライズ済みのモデルが
T-スタンスで表示されます。

4 Asset Browser の servoアセット(servo.fbxファイル)をシーンへドラッグし、
コンテキストメニューから FBX Merge > No animation を選択します。

サーボアームがシーンにロードされ、Mia の肩の上に配置されます。次の
手順では、もう 1 本の腕として、この腕を Mia にアタッチします。
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Mia とサーボアームがシーンにロードされた状
態

追加した腕をキャラクタに接続する
次の手順では、サーボアームと Mia の肩の間に親子関係を作成します。

1 Viewer ウィンドウを X-Ray 表示モードに切り替えます（Ctrl+A キー）。

注: キーボードショートカットCtrl+Aキーを押すと Normal モード、Models
Only モード、X-Ray モードが順に切り替わります。

2 Character Controls ウィンドウで、カレントキャラクタとして Mia を選択
が選択されていることを確認し、Show メニューの Skeleton オプションを
選択します(A)。また、Character Controls Show メニュー(A)で FK オプ
ションと IK オプションがオフになっている場合は、オンにします。
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A. Skeleton をオン B. Mia キャラクタにスケルトンが表示されます。

スケルトンを表示することで、Mia の肩のボーンを選択しやすくなります。

3 Viewer ウィンドウをクリックして、次の操作を実行します。
■ Ctrl+W キーを押して Schematic ビューに切り替えます。

■ Schematic ビュー内を右クリックし、コンテキストメニューから
Auto-Arrange を選択してから Arrange-All を選択します。

■ A キーを押して、Schematic ビューにすべてのノードを表示します。
Schematic ビューには、Mia のスケルトンの階層(A)、コントロールリ
グ(B)、およびサーボアームの 3 番目の階層が表示されます
(「ServoMaster」、C)。
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シーンの階層構造の Schematic ビュー: A. Mia のスケルトン B. Mia のコン
トロール リグ C. サーボ アーム

4 ビューの右側で、サーボアーム(ServoMaster)階層にズームインし(C)、
ServoMaster ノードを選択します。

ServoMaster ノードを選択

5 Producer カメラビューに切り替え(Ctrl+W キー)、Mia の右肩にズームイ
ンします。ServoMaster ノードのヌルが依然として選択されています。
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Viewer ウィンドウで ServoMaster のヌルが選択されていま
す。

6 P キーを押して Parent モードを有効にした後、ServoMaster のヌルを
Mia:RightShoulder ボーンにドラッグします(A)。

サーボアームに親子の関連付けを行うと、ボーンは緑色で強調表示されま
す。これにより、サーボアームは右肩ボーンの子になります(B)。

A. ServoMaster のヌルを Mia の右肩ボーンの子に設定 B. 親子関係が設定された
状態

7 Schematic ビューに切り替えて、サーボアームが Mia:RightShoulder ボー
ンの子になっていることを確認します。
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Schematic ビューで見た親子関係 A. Mia:RightShoulder ボーン B. サーボアーム階層

注: Mia:RightShoulder ノードは Schematic ビューの左側に表示されます。
必要に応じて、右クリックして Auto Arrange を選択し、表示を整理しま
す。

8 Producer Perspective ビューに切り替えます。

9 Mia のサーボアームの先端にある ServoControl エフェクタ(A)を選択し、
Parent モードで同様に Mia の右肩ボーンの子に設定します。

A. ServoControl エフェクタ B. 右肩ボーン
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10 Schematic ビューに切り替えて、 ServoControl エフェクタが
Mia:RightShoulder ボーンの子になっていることを確認します。

Schematic ビューで見た親子関係 A. Mia:RightShoulder ボーン B. ServoControl エ
フェクタ ノード

キャラクタエクステンションを作成する
ここでは、キャラクタエクステンションを作成してサーボアームを Mia キャラ
クタに接続することで、サーボアームと Mia キャラクタをまとめてコントロー
ルし、キーフレームを設定できるようにします。

1 Scene Browser で、Characters を展開し、Mia を右クリックして、コンテ
キストメニューから Create Character Extension を選択します(A)。
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2 Scene Browser で Character Extensions フォルダを展開し、Mia Extension
を表示します(C)。

Scene Browser: A. Mia キャラクタに追加されたキャラクタエクステ
ンション B. Scene Browser に追加された Character Extensions 項目
C. Mia キャラクタにちなんで名づけられたキャラクタエクステンショ
ン

3 Producer Perspective ビューに切り替えます。

4 Viewer ウィンドウの ServoControl エフェクタを Altキーを押しながらMia
Extension 上にドラッグし、コンテキストメニューから Add to Mia Extension
を選択します(次の図を参照)。

A. ServoControl エフェクタ B. ServoControl エフェクタを Mia
Extension に追加します。

サーボアームは Mia のキャラクタエクステンションとして定義され、キャ
ラクタの新しい「ボディパーツ」として認識されます。
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5 ServoControl エフェクタを選択したままの状態で、Properties ウィンドウ
を開きます。

注: Properties ウィンドウは、インタフェースの右側にある Asset Browser
のタブの 1 つです。

Asset Browser の Properties ウィンドウ

6 緑色のカスタムプロパティClose_Openを選択し、スライダを左右にドラッ
グします(図を参照)。
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A. サーボ アームが開きます。B. カスタム プロパティ Close_Open

Viewer ウィンドウでは、サーボアームのハサミが動きます。

7 Alt キーを押しながら、Close_Open プロパティを Mia Extension 上にドラッ
グし(A)、コンテキストメニューから Create 1 Property Referenceを選択しま
す(B)。

A. Close_Open プロパティを Mia Extension 上へドラッグします。B. Create 1
Property Reference を選択します。

8 Scene Browser でMia Extensionを選択し(A)、Properties ウィンドウの Lock
オプションを有効にして(B)、何を選択してもMia Extensionのプロパティが
開いたままになるようにします。
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A. Mia Extension を選択します。B. Properties ウィンドウの
Lock オプションをオンにします。

9 Altキーを押しながら、Mia:RightShoulder ボーンを Properties ウィンドウ
の Reference Object フィールドにドラッグして(A)、Mia の右肩ボーンを
キャラクタエクステンションのリファレンスオブジェクトとして定義しま
す(B)。

A. Mia:RightShoulder B. Mia:RightShoulder リファレ
ンス オブジェクト

10 表示される Reference Object Change ダイアログボックスで OK をクリッ
クします。
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キャラクタエクステンションのリファレンスオブジェクトは、たとえば
ポーズにキャラクタエクステンションが含まれている場合に、エクステン
ションの以降のすべての位置を計算するのに使用されます。

注: また、Include Part In Full Body オプションを使用して、Full Body キー
イングモードでキーを設定するときに、キャラクタエクステンションを
キー設定するかどうかを定義することもできます。

まとめ

このチュートリアルでは、キャラクタエクステンションを作成して、Mia キャ
ラクタに腕を追加しました。

次のチュートリアル、歩行サイクルを作成する (47 ページ)では、Pose コント
ロールを使用して、このキャラクタとキャラクタエクステンションをアニメー
トします。
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歩行サイクルを作成する

このチュートリアルでは、ポーズを使用して、歩行サイクルを作成する手順について説明しま
す。

このチュートリアルの主な項目は次のとおりです。

■ シーンを準備する (47 ページ)

■ ポーズを作成する (48 ページ)

■ ポーズを使ってアニメーションを作成する (56 ページ)

■ ポーズをミラーリングする (59 ページ)

■ アニメーションを再生する (63 ページ)

このチュートリアルで使用するアセット:

■ mia_servo.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorials フォルダ(またはシステ
ム上の MotionBuilder ディレクトリ内の Tutorials フォルダ)にあります。

シーンを準備する
この手順では、MotionBuilder シーンを準備し、このチュートリアルを開始する
のに必要なファイルを開きます。

1 メニューバーから File > New を選択し、Layout > Editing を選択します
(Ctrl+Shift+3 キー)。

5
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MotionBuilder は、新規 3D シーンを Editing レイアウトで表示します。
このレイアウトには、このチュートリアルで作業するのに必要なすべての
ウィンドウが表示されます。

2 Asset Browser で Tutorials フォルダをクリックします。

3 mia_servoアセット(mia_servo.fbxファイル）を Viewer ウィンドウにドラッ
グして、表示されるコンテキストメニューから FBX Open > No Animation
を選択します。

以下の図のように、Mia という名前のモデルが Viewer ウィンドウに表示さ
れます。

mia_servo がシーンに表示されます。

このキャラクタには、右肩のボーンを親とし、Character Extension (キャ
ラクタエクステンション)として追加されている、「サーボアーム」が含
まれています。

ポーズを作成する
この手順では、キャラクタエクステンションを含むキャラクタにいくつかのボ
ディ全体のポーズを作成して、歩行サイクルを作成します。
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1 キャラクタがまだ選択されていない場合は、Character Controls ウィンド
ウで Character Controls をクリックし、Current Character メニューから
Mia を選択します(A)。

Character Controls ウィンドウ: A. Current Character メニューから Mia
を選択

2 Ctrlキーを押しながら、手首と足首のエフェクタをクリックして選択し(A)、
Effector Pinning 領域で T および R オプションを無効化することにより、
エフェクタのピン(固定)をすべてオフにします(B)。

Character Controls ウィンドウ: A. 手首と足首のエフェクタ セルを選択
B. T および R ピン(固定)をオフ C. Full Body キーイングモードがアクティ
ブな状態

次の手順では、デフォルトの Full Body キーイングモード(C)を使用しま
す。この Full Body キーイングモードでは、ペーストしたポーズはキャラ
クタのボディ全体に配置され、キーフレームはすべてのエフェクタに配置
されます。
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3 左肩のエフェクタを選択してから R キーを押して、Mia の左腕が体の脇の、
より自然な位置に来るまでエフェクタを回転させます。右肩と右腕につい
て同じ操作を繰り返します。

肩のエフェクタを使用して、Mia の腕を Z 軸の下方向に回転

4 両手首のエフェクタを選択し、Y 軸上で上方向に移動して、肘を自然に曲
げます。

手首のエフェクタを使用して腕を Y 軸の上方向へ移動
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5 キャラクタの側面を確認できるカメラビューを選択します。たとえば、
Ctrl+R キーを押すと、Producer Right カメラビューに切り替えることがで
きます。

Producer Right カメラ ビュー

注: 見やすいように、適宜カメラビューを切り替えてください。

歩行サイクルの最初のポーズの作成:

1 Character Controls で、右ヒップ(RightHip)のエフェクタを選択し、Mia
が前に一歩踏み出すように、Z 軸に沿って右脚を前に回転(R キー)します。

2 左ヒップのエフェクタを選択し、Z 軸に沿って、左脚を後方にわずかに回
転させます。

3 Mia が自然に腕を振っているように、右肩エフェクタを選択し、右腕を後
方にわずかに回転させます。次に、左肩を選択して、左腕を前方に回転さ
せます。

4 Mia の足の Auxiliary ピボット(AnkleEffectorPivots)を選択し、足が自然な位
置につくまで回転させます。

このポーズでは、Mia の右脚から前進歩行モーションが始まります(次の図
を参照)。
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最初のポーズを作成できる状態

注: 座標変換の結果、Mia がフロア(床面)から浮いてしまった場合はいつで
も、ヒップエフェクタを選択し、Mia を下方向に移動できます。デフォル
トのフロアコントロールマーカにより、Mia の足は自然にデフォルトのフ
ロアに合わせて動作します。

5 Asset Browser ウィンドウで Pose Controls タブをクリックしてから、Create
(A)をクリックしてこのポーズを Pose ブラウザに追加します。

キャラクタエクステンションの位置は、このポーズの Mia のボディの位置
に含まれます。

6 Poses フォルダを展開してポーズを表示します。

7 作成したポーズを右クリックし、Rename を選択して名前を「Walk 01」
に変更します(B)。
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Pose Controls: A. ポーズを作成 B. ポーズの名前を「Walk 01」に変更

歩行サイクルの 2 つ目のポーズの作成:

1 次の図のように見えるように、Mia の脚と腕を配置します。右足は前で設
置し、左足は後ろに蹴り上げて前方向の力を与えています。

2 Mia:ServoControl エフェクタを選択し、Mia の正面に来るようにサーボ
アームを移動します。

3 Mia:ServoControl が選択されている状態で Asset Browser の Properties タ
ブをクリックし、Close_Open プロパティ(B)を使用してハサミを半分開き
ます(次の図を参照)。

A. 歩行サイクルの 2 つ目のポーズ B. Close_Open プロパティで、ハサミを制
御
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4 Pose Controls で Create をクリックし、このポーズに「Walk 02」と名前
を付けます(A)。

Pose Controls: A. 2 つ目のポーズの名前を「Walk 02」に
変更

歩行サイクルの 3 つ目(最後)のポーズの作成:

1 次の図のように見えるように、Mia の脚と腕を配置します。

2 Mia:ServoControl エフェクタを選択し、サーボアームを、Mia の前方ま
で、さらに伸ばします。

3 Mia:ServoControl が選択されている状態で、Properties ウィンドウの
Close_Open プロパティを使用してハサミをさらに開きます(B)。

このポーズでは、左脚は後方に移動し、サーボアームは前方に移動します。
これにより、歩行サイクルの前半の 1 歩が完成します。
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A. 歩行サイクルの 3 つ目のポーズ B. The Close_Open プロパティ

4 Pose Controls で Create をクリックし、このポーズに「Walk 03」と名前
を付けます。

現在、シーンには、3 種類のポーズがあります。3 つのポーズが、Pose ブ
ラウザにリストされています。

歩行サイクルの 3 つポーズを作成した状態
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ポーズを使ってアニメーションを作成する
次の手順では、先ほど作成した 3 種類のポーズを使用して、歩行サイクルを半
分作成します。さまざまなフレームでこれらのポーズにキーフレームを設定し
て、短い歩行アニメーションを作成します。

1 Character Controls ウィンドウで選択されているエフェクタをすべて選択
解除し、Full Body キーイングモードが選択されていることを確認します
(A)。

Character Controls: A. Full Body キーイング モードが選
択されています。

2 Pose ブラウザで、「Walk 01」ポーズをダブルクリックして Mia にペース
トします。

Pose Controls: A. 歩行サイクルの最初のポーズ B. Mia に「Walk 01」ポーズをペー
ストした状態
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Pose Controls ウィンドウの Gravity、Translation、および Rotation オプ
ションは、デフォルトでアクティブに設定されています。つまり、ペース
トしたポーズの移動と回転は、カレントキャラクタの選択されたエフェク
タの移動および回転と一致します。Gravity オプションが有効なため、ペー
スト元のポーズのオリジナルレベルで足が静止します(通常は床面の高さ)。

3 ヒップエフェクタを選択してから、Transport Controls のフレーム 0 に移
動します。

A. ヒップのエフェクタを選択 B. カレント フレームは 0

4 Key Controls ウィンドウで、Layer メニューから AnimLayer1 を選択し
(A)、Flat をクリックして、フラットなキーフレームを設定します(B)。キー
ボードの Ctrl+K キーを押しても、Flat キーフレームを設定できます。

注: Type メニューで Bezier-Auto を選択する必要があります。

Key Controls A. AnimLayer1 を選択 B. Flat キー

Key Controls ウィンドウで示されるように、キャラクタのボディ全体の位
置(B)は AnimLayer1 (A)に設定されています。Key Controls のキーイング
モード(B)は、Character Controls ウィンドウで選択されているキーイング
モードと同じになります。
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Key Controls A. AnimLayer1 を選択 B. Full Body キーイン
グ モードが選択された状態

5 フレーム 5 に移動して、次の操作を実行します。
■ Walk 02 ポーズをダブルクリックして、Mia にペーストします。

■ Ctrl キーを押しながら K キーを押して、(Flat)キーフレームを設定しま
す。

フレーム 5: A. 歩行サイクルの 2 つ目のポーズ B. Mia に「Walk 02」ポーズをペー
ストした状態

6 フレーム 10 に移動して、次の操作を実行します。
■ Walk 03 ポーズをダブルクリックして、Mia にペーストします。

■ Ctrl キーを押しながら K キーを押して、(Flat)キーフレームを設定しま
す。
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フレーム 10: A. 歩行サイクルの 3 つ目のポーズ B. Mia に「Walk 03」ポー
ズをペーストした状態

7 アニメーション全体を通してタイムスライダインジケータをドラッグし、
ここで作成した 1 歩を確認します。

3 つのキーフレーム間の補間によって 1 歩の動きが作成されます。

ポーズをミラーリングする
次の手順では、Pose ブラウザから 3 つのポーズをミラーリングして、後半の歩
行サイクルを作成します。オリジナルのポーズの後にミラーリングしたポーズに
キーフレームを設定して、短い歩行アニメーションを完成させます。

1 Pose Controls ウィンドウで Mirror オプションをオンにします(A)。
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Pose Controls: A. Mirror オプションをオン

2 フレーム 15 に移動して、次の操作を実行します。
■ 「Walk 01」ポーズをダブルクリックします(A)。

「Walk 01」ポーズがミラーリングされ、キャラクタにペーストされま
す(Bポーズをミラーペーストしたので、左脚が前に、右脚が後ろにな
り、反対側の歩行サイクルが続けられます。

■ Ctrl キーを押しながら K キーを押して、(Flat)キーフレームを設定しま
す。

フレーム 15: A. 後半の歩行サイクルの最初のポーズ B. Mia に「Walk
01」ポーズをペーストした状態
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3 フレーム 20 に移動して、次の操作を実行します。
■ 「Walk 02」ポーズをダブルクリックします(A)。

「Walk 02」ポーズがミラーリングされ、キャラクタにペーストされま
す(B)。

■ Ctrl キーを押しながら K キーを押して、(Flat)キーフレームを設定しま
す。

フレーム 20: A. 後半の歩行サイクルの 2 つ目のポーズ B. Mia に
「Walk 02」ポーズをペーストした状態

4 フレーム 25 に移動して、次の操作を実行します。
■ 「Walk 03」ポーズをダブルクリックします(A)。

「Walk 03」ポーズがミラーリングされ、キャラクタにペーストされま
す(B)。

■ Ctrl キーを押しながら K キーを押して、(Flat)キーフレームを設定しま
す。
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フレーム 25: A. 後半の歩行サイクルの 3 つ目のポーズ B. Mia に
「Walk 03」ポーズをペーストした状態

アニメーションは 6 つのキーフレームから構成されます。最初の 3 つの
キーフレームは、キャラクタの左側にミラーリングされて最後の 3 つの
キーフレームに使用され、完全な歩行動作を作成します。完全なアニ
メーションサイクルを完成するには、テイクの始点と終点を同じにする
必要があります。

5 Action タイムラインで、キーフレームをフレーム 0 からフレーム 30 にク
リック & ドラッグして、フレーム 0 のキーフレームをフレーム 30 にコピー
します。

フレーム 0 のキーフレームをフレーム 30
にコピーした状態

これでアニメーションの開始と終了の位置が同じになり、サイクルが完成
します。
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アニメーションを再生する
1 Action タイムラインをクリックし、Ctrl キーと Shift キーを押しながら A

キーを押して、Action タイムラインのアニメーションの 30 フレームすべ
てにフレームします。

アニメーションにフレーム A. Loop オプション

2 Transport Controls ウィンドウで、Loop をクリックしてから(A)、Play を
クリックします。

アニメーションを再生すると、各ループは完全な歩行サイクルを表示しま
す。

このアニメーションでは、動きがぎこちなく、足がフロア(床面)の上を滑る
場合があります。FCurves ウィンドウでアニメーションのファンクション
カーブを調整すると、動きを滑らかにすることができます。

まとめ

このチュートリアルでは、キャラクタにポーズを作成し、作成したポーズのキー
フレームをさまざまなポイントに設定し、歩行サイクルを作成しました。

注: Story ウィンドウを使用した歩行サイクルを作成したい場合は、ループを作
成してください。

次のチュートリアル、キャラクタアニメーションをリターゲットする (65 ペー
ジ)では、あるキャラクタから別のキャラクタへ、アニメーションやキャラクタ
エクステンションのターゲットを再設定します。
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キャラクタアニメーショ
ンをリターゲットする

このチュートリアルでは、キャラクタライズ済みのキャラクタから別のキャラクタにアニメー
ションをリターゲットする手順を説明します。ソースキャラクタにはキャラクタエクステンショ
ンが含まれ、ターゲットキャラクタには含まれないため、キャラクタエクステンションのリター
ゲッティングも必要です。

このチュートリアルの主な項目は次のとおりです。

■ シーンを準備する (66 ページ)

■ キャラクタアニメーションを保存する (67 ページ)

■ シーンを作成する (69 ページ)

■ キャラクタアニメーションをロードする (71 ページ)

■ アニメーションを再生する (74 ページ)

このチュートリアルで使用するアセット:

■ mia_fk_runstopturn.fbx

■ Gremlin.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorials フォルダ(またはシステ
ム上の MotionBuilder ディレクトリ内の Tutorials フォルダ)にあります。
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シーンを準備する
次の手順では、MotionBuilder シーンを準備し、このチュートリアルを開始す
るのに必要なファイルを開きます。

1 メニューバーから File > New を選択し、Layout > Editing を選択します
(Ctrl+Shift+3 キー)。

MotionBuilder は、新規 3D シーンを Editing レイアウトで表示します。
このレイアウトには、このチュートリアルで作業するのに必要なすべての
ウィンドウが表示されます。

2 Asset Browser で Tutorials フォルダをクリックします。

3 図のようにmia_fk_runstopturnアセット(mia_fk_runstopturn.fbxファイル)を
Viewer ウィンドウにドラッグして、表示されるコンテキストメニューから
FBX Open > All Takes を選択します。

Mia という名前のモデルが、「サーボアーム」キャラクタエクステンショ
ンと一緒に Viewer に表示されます。

Mia_fk_runstopturn アセットをシーンにドラッグ

4 Character Controls の Character Controls をクリックし、Current
Character メニューでMia が選択されていることを確認します(A)。
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Character Controls A. Mia がカレント キャラクタ

5 Transport Controls で、Play をクリックして(A) Mia キャラクタのアニメー
ションを確認します。

Transport Controls A. Play ボタン

キャラクタアニメーションを保存する
次の手順では、Save Character Animation オプションを使用してキャラクタア
ニメーションを保存します。これは、Load Character Animation オプションを
使用してアニメーションを簡単にロードすることができます。

1 Character Controls ウィンドウで、File > Save Character Animation を選
択します(A)。
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Character Controls A. Save Character Animation オプ
ション

2 キャラクタアニメーションを保存する場所に移動し、ファイル名を入力し
て、Save をクリックします。

Save File ダイアログ ボックス

3 表示される Save Character Animation Options ダイアログボックスで、
Save Control Rig オプションと Save Character Extensions をアクティブに
して、Save をクリックします。
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Save Character Animation Options ダイアログ ボッ
クス

アニメーションとキャラクタエクステンションが .fbx ファイルとして保存
されます。

シーンを作成する
次は、シーンを作成します。

1 Ctrl+N キーを押してシーンを作成します。

2 表示される Save changes ダイアログボックスで Don’t Save をクリックし
ます。

Save changes ダイアログボックス

3 Asset Browser から Gremlin アセットをシーンにドラッグし、FBX Open >
No animation を選択します。
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Gremlin をシーンにドラッグします。

4 Character Controls の Current Character メニューで Gremlin が選択され
ていることを確認します(A)。

Character Controls: A. Gremlin がカレント キャラクタ
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キャラクタアニメーションをロードする
次に、前の手順で保存したキャラクタアニメーションをロードします。

1 Character Controls ウィンドウで、File > Load Character Animation を選
択します(A)。

Character Controls: A. Load Character Animation オプション

2 このチュートリアルで先ほど保存した .fbx ファイルに移動してこれを選択
し、Open をクリックします。

Load Character Animation Options ダイアログボックスが表示されます。
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Load Character Animation Options ダイアログ ボックス

3 選択する設定:

■ Load Technique 領域(A)で、Plot to Control Rig オプションをオンにし
ます。

■ Control Rig 領域で、Replace Control Rig オプション(B)をオンにしま
す。

■ Control Rig 領域で、Reset Control Rig’s Rotation DOF オプション(C)
をオンにします。

■ Control Rig 領域で、Remove Constraint Reference オプション(D)がオ
ンになっていることを確認します。

■ Character Extensions 領域で、Process Animation オプション(E)をオ
ンにします。

■ Character Extensions 領域で、Copy Missing Character Extensions オ
プション(F)をオンにします。
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Load Character Animation Options ダイアログ ボックスでの設定

4 Open をクリックします。

Mia のアニメーション、コントロールリグ、キャラクタエクステンション
が Gremlin キャラクタにロードされます。
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Mia のアニメーションとコントロール リグが Gremlin キャラクタ
にロードされます。

Mia のサーボアームは、右肩の FK エフェクタにペアレント化されている
ため、サーボアームは同じように Gremlin キャラクタにアタッチされま
す。

アニメーションを再生する
結果のアニメーションを再生します。

1 Transport Controls の Play をクリックしてアニメーションを再生します
(A)。
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A. Mia のアニメーションを使用する Gremlin B. Gremlin のコントロー
ル リグ

サーボアームとアニメーションの両方がどのように Gremlin キャラクタ上
に転送されるかに注意してください(A)。Gremlin のオリジナルのコント
ロールリグがシーン中央に残されます(B)。これは、Load Character
Animation Options ダイアログボックスの Replace Control Rig を選択し
たため発生する現象です。Gremlin のコントロールリグが Mia のコント
ロールリグと置き換えられています。

2 Scene Browser で Control Rigs を展開し、コントロールリグ(Gremlin の
オリジナルのコントロールリグ)を右クリックして、Delete を選択しシーン
をクリーンアップします。

Scene Browser: A.コンテキストメニューの Delete
ボタン
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まとめ

このチュートリアルでは、あるキャラクタライズされたキャラクタから、別の
キャラクタにアニメーションをリターゲットして、ソースキャラクタからター
ゲットキャラクタにキャラクタエクステンションを転送しました。

次のチュートリアルキャラクタアニメーションを編集する (77 ページ)では、オ
リジナルのアニメーションからレイヤ上のアニメーションを編集した後、すべて
のレイヤをマージします。
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キャラクタアニメーショ
ンを編集する

このチュートリアルでは、アニメーションのレイヤを作成して、アニメーションを変更する方法
を説明します。キャラクタのコントロールリグにプロット済みのアニメーションを 2 つの個別
のレイヤで修正して、オリジナルのアニメーションと修正したアニメーションを結合します。

このチュートリアルの主な項目は次のとおりです。

■ シーンを準備する (77 ページ)

■ キャラクタエクステンションのアニメーションを変更する (79 ページ)

■ 頭部のアニメーションを変更する (84 ページ)

■ アニメーションをプロットする (88 ページ)

■ 作成されたテイクを再生する (89 ページ)

このチュートリアルで使用するアセット:

■ mia_runstopturn.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorials フォルダ(またはシステ
ム上の MotionBuilder ディレクトリ内の Tutorials フォルダ)にあります。

シーンを準備する
次の手順では、MotionBuilder シーンを準備し、このチュートリアルを開始する
のに必要なファイルを開きます。
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1 メニューバーから File > New を選択し、Layout > Editing を選択します
(Ctrl+Shift+3 キー)。

MotionBuilder は、新規 3D シーンを Editing レイアウトで表示します。
このレイアウトには、このチュートリアルで作業するのに必要なすべての
ウィンドウが表示されます。

2 Asset Browser で Tutorials フォルダをクリックします。

3 mia_runstopturn アセット(mia_runstopturn.fbx ファイル）を Viewer ウィン
ドウにドラッグして(A)、表示されるコンテキストメニューから FBX Open
> run_stop_turn180 を選択します。

Mia という名前のモデルが Viewer に表示されます(B)。

A. mia_runstopturn アセット B. シーンにロードされた Mia キャラクタ

4 Viewer ウィンドウ内をクリックし、Ctrl+R を 2 回押して、Producer Left
カメラに切り替えます。ズームアウトして、グリッド全体を表示します。
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Producer Left カメラ ビュー

キャラクタエクステンションのアニメーション
を変更する

次の手順では、アニメーションを作成して、サーボアームキャラクタエクステ
ンションのアニメーションを変更します。

1 テイク全体を再生して（Ctrl+スペースバー）、すべてのモーションを確認
します。サーボアームに特に注目してください。

現在、サーボアームは、赤いワイヤフレームエフェクタの方向を指しなが
ら、Mia の前で細かい上下動を繰り返しています。このエフェクタは Mia
の肩にペアレント化されているので、Mia が走る動作につれてサーボアー
ムが跳ねるように動きます。

2 Ctrl+Home キーを押してテイクの先頭に戻り、もう一度フレーム 50 まで再
生します。
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フレーム 50 での Mia

3 Key Controls でレイヤメニューから AnimLayer1 を選択します(A)。

Key Controls A. AnimLayer1 を選択

これにより、BaseAnimation レイヤにオリジナルのアニメーションを保持
しつつ、アニメーションレイヤにキーフレームを設定できます。

4 Mia:ServoControl エフェクタを選択し(A)、Key Controls の Zero をクリッ
クしてフレーム 50 にゼロキーフレームを設定します(B)。
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フレーム 50 A. Mia:ServoControl エフェクタ B. Zero キーフレーム
ボタン

5 Mia:ServoControl エフェクタを選択した状態のまま、フレーム 150 に移動
し、ゼロキーフレームを設定します。

フレーム 150 A. Mia:ServoControl エフェクタを選択 B. Zero キーフレー
ム ボタン

6 フレーム 80 に移動します。

このフレームで、Mia がサーボアームを上げるようにアニメーションを変
更します。
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フレーム 80

7 次の操作を行います。
■ Viewer ウィンドウ内をクリックし、Tキーを押して Translation モード

をアクティブにします。

■ Viewer ウィンドウの下部分で、Translation XYZ の値を 200、-30、10
に設定します(A)。

■ キーフレームを設定します(B)。

フレーム 80 A. Translation 値を設定 B. キーフレームを設定
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8 フレーム 120 に移動して、次の操作を実行します。
■ Mia:ServoControl エフェクタの Translation XYZ の値を 45、16、14

に設定します(A)。

■ キーフレームを設定します(B)。

フレーム 120 A. Translation XYZ の値を設定 B. キーフレームを設定

9 フレーム 130 に移動して、次の操作を実行します。
■ Translation XYZ の値を 35、-25、68 に設定します(A)。

■ キーフレームを設定します(B)。

フレーム 130 A. Translation XYZ の値を設定 B. キーフレームを設定
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10 アニメーションを再生します。

Mia が速度を緩めて振り返る際に、サーボアームを上げる動作になりまし
た。

頭部のアニメーションを変更する
次の手順では、別のレイヤを使用して、アニメーションを改善します。Mia が
走っている間、停止したときと振り向く直前に頭部が動くようにします。

1 フレーム 30 に移動します。

このフレームでは、Mia の頭部は走っている方向にまっすぐ向いています。
このモーションを変更して、Mia が頭部を動かすようにします。

フレーム 30 での Mia

2 Key Controls ウィンドウで、Layer メニューから New Layer を選択し(A)、
頭部のアニメーションを修正するためのレイヤを作成します。

Key Controls ウィンドウ A. Layer メニュー > New Layer オ
プション
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「AnimLayer2」という名前のレイヤが追加されます。

3 Character Controls ウィンドウで頭部のエフェクタを選択し(A)、Body Part
キーイングモードに切り替えます(B)。

Character Controls ウィンドウ A. Head エフェクタを選択し
ます。B. Body Part キーイング モードに切り替えます。

ボディ全体ではなく頭部だけにキーフレームを設定すれば良いため、この
レイヤでアニメーションを作成するときは、Body Part キーイングモード
を使用できます。

4 Key Controls で Zero をクリックしてゼロキーフレームを設定します(A)。

Key Controls A. Zero keyframe ボタン

5 フレーム 150 に移動して、別のゼロキーフレームを設定します。
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フレーム 150 A. ゼロ キーフレームを設定します。

6 フレーム 60 に移動して、次の操作を実行します。
■ 頭部のエフェクタを選択したままの状態で、Rotation モードをアクティ

ブにします(Viewer ウィンドウ内でクリックして R を押します)。

■ Viewer ウィンドウの下部分で、Rotation XYZ の値を 35、0、2 に設定
します(A)。

■ キーフレームを設定します(B)。

フレーム 60 A. XYZ Rotation プロパティを設定します。B. キーフレームを
設定します。
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7 フレーム 90 に移動して、次の操作を実行します。
■ Rotation XYZ の値を 42、0、-5 に設定します(A)。

■ キーフレームを設定します(B)。

フレーム 90 A. Rotation の値を調整します。B.キーフレームを設定します。

8 フレーム 105 に移動して、次の操作を実行します。
■ Rotation XYZ の値を 30、-5、0 に設定します(A)。

■ キーフレームを設定します(B)。

フレーム 105 A. Rotation の値を調整します。B. キーフレームを設定しま
す。

頭部のアニメーションを変更する | 87



9 頭部のエフェクタを選択解除し、アニメーションを再生します。

Mia が走ると、頭部が動きます。

アニメーションをプロットする
次は、アニメーションデータをプロットして、オリジナルのデータと修正した
データを結合します。プロットによってすべてのアニメーションは BaseAnimation
レイヤにマージされます。

1 Character Controls ウィンドウの Edit メニューから、Plot Character を選
択します(A)。Character Settings の Plot Character ボタンを使用すること
もできます。

Character Controls ウィンドウ A. Edit メニューから Plot
Character を選択します。

2 最初に表示される Character ダイアログボックスで、Skeleton をクリック
して(A)、次に表示される 2 つ目の Character ダイアログボックスで図のよ
うにオプションが選択されていることを確認して Plot をクリックします
(B)。
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Character plotting ダイアログ ボックス A. Skeleton をクリックしま
す。B. Plot をクリックします。

すべてのアニメーションデータが、コントロールリグから、カレントテイ
クの BaseAnimation レイヤのキャラクタのスケルトンに転送されます。

3 プロットされたキーフレームを表示するには、BaseAnimation レイヤと
Mia のスケルトンを選択します。Transport Controls のタイムラインに多
数のキーフレームが表示されます。

多数のキーフレームを備えた一連のファンクションカーブとして、FCurves
ウィンドウにプロットしたデータを表示できます。

作成されたテイクを再生する
テイクを再生してアニメーションを確認します。

サーボアームを上げ、頭部を動かすアニメーションが、走って方向転換をする
Mia のオリジナルのアニメーションにマージされています。

まとめ

このチュートリアルでは、2 つの異なるレイヤ上にキーフレームを設定してオリ
ジナルのアニメーションを変更した後、アニメーションを 1 つのテイクにマー
ジしました。次のチュートリアル、ループを作成する (91 ページ)では、Story
ウィンドウを使用した歩行サイクルの作成方法について学びます。
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ループを作成する

このチュートリアルでは、キャラクタをアニメートし、Story ウィンドウで歩行サイクルを作成
する手順について説明します。

このチュートリアルの主な項目は次のとおりです。

■ シーンを準備する (91 ページ)

■ キャラクタトラックを作成する (92 ページ)

■ ポーズを作成する (97 ページ)

■ クリップをマッチさせる (100 ページ)

■ クリップを処理する (102 ページ)

■ 歩行サイクルをテストする (105 ページ)

このチュートリアルで使用するアセット:

■ mia_servo.fbx

■ walkaround.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorials フォルダ(またはシステ
ム上の MotionBuilder ディレクトリ内の Tutorials フォルダ)にあります。

シーンを準備する
次の手順では、MotionBuilder シーンを準備し、このチュートリアルを開始する
のに必要なファイルを開きます。
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1 メニューバーから File > New を選択し、Layout > Story を選択します
(Ctrl+Shift+5 キー)。

MotionBuilder は、Story レイアウトを使用して新しい 3D シーンを表示し
ます。このレイアウトには、このチュートリアルで作業するのに必要なす
べてのウィンドウが表示されます。

2 Asset Browser で Tutorials フォルダをクリックします。

3 mia_servo アセット (mia_servo.fbx ファイル)を Viewer ウィンドウにドラッ
クして、次に FBX Open > No Animation を選択します。

mia_servo アセットが、Viewer ウィンドウに T-スタンスで表示されます。

T-スタンスの Mia とサーボ アーム

キャラクタトラックを作成する
次の手順では、Story ウィンドウでキャラクタトラックを作成し、トラックが作
用するキャラクタを定義し、アニメーションを追加します。

1 Story ウィンドウで、Action Track リストを右クリックし(A)、コンテキス
トメニューから Insert > Character Animation Track を選択します。
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Story ウィンドウ A. Action Track リスト

Character Animation トラックが追加されます(A)。

Story ウィンドウ A. キャラクタ トラック

2 トラックの Character メニューで Mia を選択します(A)。
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Story ウィンドウ A. Character メニューで Mia を選択します。

3 Asset Browser からキャラクタトラックに walkaround.fbx をドラッグしま
す。

walkaround.fbx ファイルをキャラクタ トラックにドラッグします。

4 フレーム 0 から始まるようにクリップをドラッグします。クリップはフレー
ム 98 で終わらせる必要があります。
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キャラクタ トラックでクリップをフレーム 0 にドラッグします。

注: キャラクタトラックで Ctrl キーを押しながらドラッグするとズーム
し、Shift キーを押しながらドラッグするとパンします。

5 アニメーションを再生します(Ctrl+スペースバー)。

フレーム 0 では、キャラクタの右足が前、左足が後ろになっています。フ
レーム 98 で、Mia は進む方向を変えます。この時点でアニメーションを
ループすると、歩行サイクル内にジャンプが生じてしまいます。

6 フレーム 40 に移動します。このフレームでは、Mia の右足は地面に着地し
ていて、左足はわずかに持ち上がっています。

Mia を正面から確認するためカメラビューを変更します。

フレーム 40 での Mia
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7 クリップが選択されたままの状態で、Razor ボタンをクリックします(A)。

Story ウィンドウ A. Razor ボタン

クリップはフレーム 40 で 2 つに切断されます。

オリジナルのクリップが 2 つに切断されました。

8 フレーム 75 に移動します。このフレームでは、Mia はフレーム 40 とほぼ
同じポーズになっています。

フレーム 75 での Mia
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9 2 番目のクリップを選択していない場合はそれを選択し、Razor ボタンをク
リックします。

2 番目のクリップがフレーム 75 で切断され、クリップは 3 つになります。

キャラクタ トラック内の 3 つのクリップ

10 必要なのは中央のクリップだけなので、Ctrl キーを押しながら 1 番目のク
リップをクリックして 1 番目のクリップと 3 番目のクリップを選択した後、
Delete キーを押します。

11 フレーム 0 で始まるように残ったクリップをドラッグします。

クリップはフレーム 0 で始まり、フレーム 35 で終わります。

ポーズを作成する
1 フレーム 0 に移動します(Ctrl+Home)。

2 Character Controls ウィンドウで、Current Character から Mia が選択さ
れていることを確認し(A)、ヒップエフェクタを選択します(B)。

Character Controls ウィンドウ A. Current Character メニューか
ら Mia を選択します。B. ヒップ エフェクタを選択します。

3 Asset Settings ウィンドウで、Pose Controls タブをクリックします。
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4 Pose Controls で Create (A)をクリックし、Poses フォルダを展開して作成
したポーズを確認します。ポーズの名前はデフォルトで「Mia Pose」となっ
ています(B)。

Pose Controls ウィンドウ A. Create ボタン B. Mia Pose

5 フレーム 35 に移動して、次の操作を実行します。
■ Story ウィンドウで、キャラクタトラックの Animate オプションをア

クティブ化します(A)。Animate オプションがアクティブの場合、ポー
ズのトラックへのペーストしかできません。

キャラクタ トラック A. Animate オプションをアクティブ化します。

■ Character Controls ウィンドウで Right Ankle エフェクタ(A)を右クリッ
クし、表示されるメニューから RightAnkleEffector を選択します。

98 | 第 8 章   ループを作成する



Character Controls ウィンドウ A. Right Ankle エ
フェクタ

■ Pose Controls ウィンドウで Paste をクリックします(A)。

Pose Controls ウィンドウ A. Paste ボタ
ン

1 フレームのクリップがフレーム 35 のキャラクタトラックに表示されま
す。

このクリップには、ペーストしたポーズのデータが含まれます。Mia の歩
行開始と歩行終了のポーズがまったく同じになります。

キャラクタ トラック A. フレーム 35 の新しいクリップ
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6 ジョグ(J キーを押しながらドラッグ)するか、Ctrl+左矢印キーと Ctrl+右矢
印キーを使用して、アニメーション内をフレームごとにゆっくり移動しま
す。アニメーションの始めと終わりは同じポーズですが、始めと終わりの
クリップの間に小さなジャンプがあります。次の手順でジャンプを削除し
ます。

クリップをマッチさせる
次の手順では、2 つのクリップをマッチさせてブレンドし、アニメーション内の
ジャンプを削除します。

1 トラックの下の空いている部分をクリックし、A を押してクリップをズー
ムインします。

2 2 番目のクリップを選択します。

キャラクタ トラック A. 2 番目のクリップを選択します。

3 Right Ankle エフェクタが Character Controls ウィンドウで選択されたま
まの状態であることを確認します(A)。

Character Controls ウィンドウ A. Right Ankle
エフェクタ

4 Story ウィンドウで Match Options ボタンをクリックします(A)。
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Story ウィンドウ A. Match Options ボタン

5 表示される Match Options ダイアログボックスで OK をクリックします
(A)。

Match Options ダイアログ ボックス A. OK ボタン

6 Pose Controls が表示されている Asset Settings ウィンドウで、Asset Settings
タブをクリックし、Story ウィンドウ内で 2 番目のクリップをダブルクリッ
クして設定を表示します。

7 Asset Settings で、In フィールド(A)の値を 29 に設定します。
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Asset Settings ウィンドウ A. In ポイントをフレーム 29 に設定
します。

8 Asset Settings ウィンドウの Out フィールドに値 36 を入力します。

9 2 番目のクリップはフレーム 29 で始まるようになり、フレーム 36 で終わ
るように 1 番目のクリップと相互にブレンドします。このブレンドにより、
クリップ間の移行が少しだけ滑らかになります。

2 番目のクリップはフレーム 29 で始まり、フレーム 36 で終わります。

10 アニメーションを再生します。Mia が歩き、歩行開始とと歩行終了のポー
ズは同じになります。

クリップを処理する
次の手順では、2 つのクリップを処理して単一のクリップとして保存します。そ
の後、この新しいクリップを使用して、別のキャラクタをアニメートします。

1 キャラクタトラックのキャラクタ名の近くで右クリックし、コンテキスト
メニューから Frame Start/End を選択します(A)。クリップの長さに合わせ
てタイムレンジのサイズが変更されます。
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キャラクタトラックのコンテキストメニュー A. Frame Start/End オプショ
ンを選択します。

2 キャラクタトラックをもう一度右クリックし、コンテキストメニューから
Process Track/Subtracks To New Clip オプションを選択します(A)。

キャラクタトラックのコンテキストメニュー A. Process Tracks/Subtracks
To New Clip オプション

3 表示されるダイアログボックスで OK をクリックします。
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Process Track and Subtracks ダイアログボック
ス

4 表示される Save Clip ダイアログボックスで、新しいクリップを
mia_walk_cycle.fbx という名前で保存します。

このチュートリアルを完了するには、保存したクリップが必要になります。

Save Clip ダイアログ ボックス

Story ウィンドウに、新しい mia_walk_cycle.fbx クリップを含む 2 番目の
キャラクタトラックが表示されます(A)。
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Story ウィンドウ A. 新しい mia_walk_cycle.fbx クリップ

歩行サイクルをテストする
次の手順では、新しい歩行サイクルクリップをテストして、滑らかにループす
るかどうかを確認します。

1 (A)のように、Loop/Scale オプションが Loop に設定されていることを確認
します。

Story ウィンドウ A. Loop/Scale オプションは Loop に設定されています。

2 キャラクタトラックをズームアウトし、mia_walk_cycle クリップの最後
をフレーム 140 まで伸ばします(A)。クリップは 4 回ループされます。

キャラクタ トラック A. クリップをフレーム 140 まで引き伸ばします。
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3 任意のキャラクタトラックを右クリックし、コンテキストメニューから
Frame Start/End を選択します。

4 1 番目のキャラクタトラックの Mute ボタンをクリックし(A)、トラックを
無効にします。

キャラクタ トラック A. Mute をクリックします。

5 アニメーションを再生します。Mia は、140 フレームの間、滑らかに歩行
します。

まとめ

このチュートリアルでは、短いアニメーションクリップから、ループする歩行
サイクルを作成しました。次のチュートリアル、クリップを操作する (107 ペー
ジ)では、クリップを修正することでキャラクタアニメーションを編集する方法
を学習します。
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クリップを操作する

このチュートリアルでは、クリップを操作してキャラクタアニメーションを変更するために必要
な手順について説明します。

このチュートリアルでは、以下の方法について説明します。

■ シーンを準備する (107 ページ)

■ 方向転換を作成する (109 ページ)

■ 2 つのクリップをブレンドする (113 ページ)

■ クリップを追加する (115 ページ)

■ クリップをマッチさせる (116 ページ)

このチュートリアルで使用するアセット:

■ mia_story.fbx

■ run_boom.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorials フォルダ(またはシステ
ム上の MotionBuilder ディレクトリ内の Tutorials フォルダ)にあります。

シーンを準備する
以下の手順では、MotionBuilder シーンを準備し、このチュートリアルを開始す
るのに必要なファイルを開きます。
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1 メニューバーから File > New を選択し、Layout > Story を選択します
(Ctrl+Shift+5 キー)。

MotionBuilder は、Story レイアウトを使用して新しいシーンを表示しま
す。このレイアウトには、このチュートリアルで作業するのに必要なすべ
てのウィンドウが表示されます。

2 Asset Browser で Tutorials フォルダをクリックします。

3 mia_storyアセット(mia_story.fbxファイル)を Viewer ウィンドウにドラッグ
して(A)、次に FBX Open > All Takes を選択します。

Mia という名前のモデルが Viewer ウィンドウに表示されます(B)。

ファイルのロード A.  Asset Browser から mia_story をドラッグ B. Mia モ
デルがロードされた状態

Story ウィンドウには、クリップを含む、Clip_Run_Loop という名前のト
ラックがあります。Mia は、トラックの Character メニューで選択されま
す。

108 | 第 9 章 クリップを操作する



4 Story ウィンドウで、Story ボタン(A)がまだオンになっていない場合は、そ
れを選択してから Character トラック (B)をクリックし、A キーを押してク
リップをフレームします。

Story ウィンドウ A. Story ボタンを選択します。B. Character トラックに 1 つの
クリップが表示されています。

5 アニメーションを再生します(Ctrl+スペースバー)。すべてのアニメーション
を確認するには、Viewer ウィンドウでズームアウトする必要があることが
あります。

方向転換を作成する
以下の手順では、クリップを 2 つに切断し、次にゴーストクリップベクトルを
回転して Mia を走らせながら方向転換させます。

1 フレーム 14 に移動します。

このフレームで、以下の図のように、Mia の左足は地面に着地しています。
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フレーム 14 での Mia

2 以下の図のように、クリップ(B)を選択し、Razor ボタン(A)をクリックしま
す。

Story ウィンドウ A. Razor ボタン B. 選択したクリップ

クリップがフレーム 14 で 2 つのクリップに切断されます(A)。

キャラクタトラック A. クリップがカレントタイムで 2 つのクリッ
プに切断されます。

110 | 第 9 章   クリップを操作する



3 以下の図のように、Viewer ウィンドウで X-Ray 表示モードに切り替え、
キャラクタトラック(A)の Ghost オプションがアクティブになっているこ
とを確認します(A)。

キャラクタ トラック A. アクティブな Ghost オプション

4 フレーム 0 に移動します(Ctrl+Home)。

Ghost オプションがアクティブな場合、以下の図のように、Viewer ウィン
ドウにゴーストが表示されます。

クリップベクトルゴーストは、各クリップの最初と最後を表します。ク
リップごとに、選択して操作できる 1 つのクリップベクトルゴーストがあ
ります(B および C)。

フレーム 0 での Mia A. モデル ゴースト B. 1 番目のクリップのゴースト クリップ
ベクトル C. 2 番目のクリップのゴースト クリップ ベクトル

5 Story ウィンドウで、2 番目のクリップが選択されていない場合はそれを選
択します(A)。

キャラクタ トラック A. 2 番目のクリップは選択されています。
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Viewer ウィンドウで、選択したクリップのゴーストクリップベクトルも
選択されます。

6 Viewer ウィンドウでクリックし、キーボードショートカット R キーを押
します。

以下の図のように、選択したクリップベクトルゴーストの一端に回転リン
グが表示されます。

クリップベクトルの同じポイントにリングが表示されない場合は、クリッ
プベクトルのインポイントをダブルクリックして選択します。

A. 回転リング B. 2 番目のゴースト クリップ ベクトルの In ポイント

7 以下の図のように(A)、Viewer ウィンドウの Rotation Y-axis フィールドに
値 -70 を入力します。

クリップベクトルが Mia の右の方を向きます(B)。

ヒント: 緑色の回転リングをドラッグして、クリップベクトルを手動で回
転することもできます。
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A. Rotation Y-axis フィールド B. ゴースト クリップ ベクトルが回転しています。

8 Viewer ウィンドウ内で J キーを押しながらドラッグし、フレーム 10 から
20 までをゆっくりした速度でジョグします。

Mia は走らせながら方向転換しますが、フレーム 14 で Mia の足がわずか
にジャンプしています。このジャンプを削除するには、クリップをブレン
ドする必要があります。

2 つのクリップをブレンドする
以下の手順では、2 つのクリップをブレンドして、Mia が方向転換するときに発
生するアニメーションのジャンプを削除します。

1 Story ウィンドウで Loop オプションがアクティブになっていることを確認
します(A)。
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Story ウィンドウ A. Loop に設定された Loop/Scale オプション

2 ユーザインタフェースの右下にある Asset Settings ウィンドウ内で、1 つ
目のクリップをダブルクリックして設定を表示します。

3 Asset Settings で、Out フィールド(A)の値を 19 に設定します。

Asset Settings ウィンドウ A. 19 に設定された Out フィールド

以下の図のように(A)、1 番目のクリップが 2 番目のクリップとオーバーラッ
プし、相互にブレンドされます。

キャラクタ トラック A. 相互にブレンドされたクリップ
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4 アニメーションを再生します。

フレーム 14 でのジャンプが解消されました。

クリップを追加する
以下の手順では、Story ウィンドウのキャラクタトラックにクリップを追加しま
す。

1 キャラクタトラックの下の空白をCtrlキーを押しながらドラッグしてから、
Shift キーを押しながらドラッグしてズームアウトし、クリップの横に空間
を作ります。

2 Asset Browser の Tutorials フォルダから、クリップの右側のキャラクタト
ラックの空白の部分に run_boom.fbx ファイルをドラッグします。

キャラクタ トラックに追加された run_boom.fbx クリップ

3 フレーム 46 から始まるようにクリップをドラッグします。
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注: 以下の図のように、2 番目のクリップの最後に揃えて配置する必要があ
ります。

新しいクリップはフレーム 46 から始まります。

4 新しいクリップを選択解除し、次にキャラクタトラックを右クリックし、
コンテキストメニューから Frame Start/End を選択します。

5 アニメーションを再生します(Ctrl+スペースバー)。

Mia は、走って方向転換しますが、アニメーションにジャンプしてしまう
場所があるため、爆風を受けたかのように前方に投げ出されます。

クリップをマッチさせる
以下の手順では、最後のクリップを前のクリップに一致させて、アニメーション
内のジャンプを削除します。

1 フレーム 0 に移動します。

2 Viewer ウィンドウで、Schematic ビューに切り替え、Mia:RightFoot ノー
ドを選択します(A)。

このノードは Mia の右足指を表しており、マッチさせるオブジェクトとし
て使用されます。

Schematic ビュー A. 選択された Mia:RightFoot ノード
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3 Producer Perspective カメラビューに切り替えます。

4 Story ウィンドウで、3 番目のクリップを選択し(A)、Match Options ボタ
ンをクリックします(B)。

Story ウィンドウ A. 選択された 3 番目のクリップ B. Match Options ボ
タン

5 以下の図のように、表示される Match Options ダイアログボックスで、
選択されていない場合は Match Object メニュー(A)で Mia:RightFoot を選
択し、To Previous Clip (B)と Between Previous Clip and Selected Clip (C)
を選択します。

Match Options ダイアログ ボックス A. Match Object B.
Match Clip C. Match Time

Translation オプションと Rotation オプションはすでに選択されています。

6 OK をクリックします。
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最後のクリップベクトルが、前のクリップとマッチするように移動します。

7 Mia:RightFoot を選択解除します(Shift+D キー)。

8 アニメーションを再生します。

Mia は走って方向転換し、前方に投げ出されます。アニメーションのジャ
ンプが解消されました。

まとめ

このチュートリアルでは、連続するアニメーションのクリップを 2 つに切断し、
1 つのクリップベクトルゴーストを回転してキャラクタを走らせながら方向転
換させました。さらに異なるアニメーションの別のクリップを追加し、3 つのク
リップをすべて、1 つのシームレスなアニメーションシーケンスへとブレンド
しました。

次のチュートリアル(MotionBuilder に 3ds Max ファイルをインポートする(119
ページ))では、3ds Max のスケルトンとキャラクタを MotionBuilder にエクス
ポートし、コントロールリグを追加し、スケルトンとキャラクタをキャラクタ
ライズします。さらに、MotionBuilder でキャラクタをアニメートしてから、
キャラクタとアニメーションを 3ds Max にエクスポートします。
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MotionBuilder に 3ds Max
ファイルをインポートす
る

このチュートリアルでは、3ds Max で作成したキャラクタを MotionBuilder にインポートし、
完全に編集可能なアニメートされたキャラクタとして 3ds Max にエクスポートするために必要
な手順について説明します。

注: このチュートリアルは、執筆時点での最新バージョンの 3ds Max、MotionBuilder、
3ds Max FBX プラグインを使用することを前提としています。

このチュートリアルでは、3ds Max で作成された次の 3 種類のアニメート可能なスケルトンを
FBX フォーマットで MotionBuilder にインポートしてアニメートする方法を説明します。

■ 3ds Max の標準的なボーンシステムのスケルトン

■ Biped システムのスケルトン

■ スケルトンがバインドされているスキンキャラクタ

このチュートリアルには、プロセスは同じですが状況が異なる 3 つの小さなチュートリアルが含
まれています。各自のニーズに合った相互運用手順を選んでください。あるいは、MotionBuilder
と 3ds Max の相互運用についてより深く学びたい方は、すべてのチュートリアルを行うことを
お勧めします。

このチュートリアルのセットでは、以下の方法について説明します。

■ 2 種類の 3ds Max スケルトンと 3ds Max キャラクタをエクスポートし、MotionBuilder に
インポートする

■ コントロールリグを追加して、スケルトンとキャラクタをキャラクタライズする

10
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■ キャラクタをアニメートし、3ds Max にインポートし直すための準備を行う

このチュートリアルの主なトピックは次のとおりです。

■ このチュートリアルの準備 (120 ページ)

■ 3ds Max のスケルトン (121 ページ)

■ 3ds Max の Biped (135 ページ)

■ 3ds Max のキャラクタ (145 ページ)

■ 3ds Max のキャラクタを MotionBuilder でアニメートする (153 ページ)

■ キャラクタをエクスポートしてアニメーションを 3ds Max にインポートし直す(166ページ)

注: このチュートリアルの手順では MotionBuilder のキーボードショートカットを
使用していますが、3ds Max のキーボードショートカットを使用することもできま
す。その場合は、MotionBuilder のメニューバーから Settings > Keyboard
Configuration > 3ds Max を選択してください。MotionBuilder Help の「キーボー
ドショートカット」の「3ds max キーボードショートカット」に、3ds Max のキー
ボードショートカットの一覧があります。

このチュートリアルの準備
このチュートリアルを行うには、システムに最新バージョンの 3ds Max、
MotionBuilder、3ds Max FBX プラグインがインストールされている必要があ
ります。

3ds Max の最新バージョンをお持ちでない場合は、オートデスクの Web サイト
(http://www.autodesk.co.jp/3dsmax)からソフトウェアの体験版をダウンロードで
きます。

また、3ds Max FBX プラグインの最新バージョンは、
http://www.autodesk.co.jp/fbx からダウンロードできます。

注: FBX プラグインのデフォルトのインストールディレクトリは C:\Program
Files\Autodesk\FBX\FbxPlugins です。

このチュートリアルは、必要な部分だけを行ってもかまいません。
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このチュートリアルで使用するアセット:

■ skeletons.max

■ bone_skeleton.FBX

■ bone_skeleton_characterized.FBX

■ biped.FBX

■ Pepe.max

■ Pepe.FBX

■ Pepe_rigged.FBX

■ IceSlip.fbx

■ Pepe_Mocap.FBX

■ Pepe_keyanim.FBX

■ Pepe_plotted.FBX

■ Pepe_plotted.max

チュートリアル用のアセットは、Asset Browser の Tutorials フォルダ(またはシ
ステム上の MotionBuilder ディレクトリ内の Tutorials フォルダ)にあります。

3ds Max のスケルトン
このチュートリアルでは、3ds Max の標準的なボーンシステムのスケルトン
データを FBX フォーマットでエクスポートし、MotionBuilder にインポートし
てキャラクタライズする(アニメートできる状態にする)方法を説明します。

このチュートリアルで使用するアセット:

■ skeletons.max

このチュートリアルの結果のアセット:

■ bone_skeleton.FBX

■ bone_skeleton_characterized.FBX
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注: チュートリアル用のアセットは、Asset Browser の Tutorials フォルダ(または
システム上の MotionBuilder ディレクトリ内の Tutorialsフォルダ)にあります。

3ds Max のスケルトンをエクスポートする
ここでは、3ds Max の標準的なボーンシステムのスケルトンデータを、
MotionBuilder でアニメートできるように FBX フォーマットでエクスポートし
ます。

スケルトンを FBX フォーマットでエクスポートするには:

1 3ds Max を起動します。

2 アプリケーションメニューから[開く] > [開く]を選択します。

3 [ファイルを開く]ダイアログボックスで、MotionBuilder のルートディレ
クトリの Tutorials フォルダに移動し、シーンファイル skeletons.max を開
きます。[ファイルのロード:単位の不一致]ダイアログボックスが表示され
た場合は、[ファイルの単位スケールを採用しますか?]を選択して[OK]をク
リックします。

skeletons.max ファイルを開くと、2 つのスケルトンが表示されます。左の
スケルトン(A)は 3ds Max の標準的なボーンシステムで作成されたもので、
右のスケルトン(B)は 3ds Max の Biped 作成オプションを使用して作成さ
れたものです。

2 つのスケルトン A. 3ds Max の標準的なボーンシ
ステムのスケルトン B. 3ds Max の Biped スケルト
ン
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これらのスケルトンは T ポーズをとっています。アニメータは通常、この
ポーズでスキニングを行います。

注: キャラクタを MotionBuilder 用にエクスポートする場合は、あらかじ
めこれと同じ T ポーズをとらせておく必要があります。また、スケルトン
が Y 軸の負の方向を向いていることを確認してください(3ds Max の Biped
システムを使用して作成したスケルトンは自動的にこの方向を向きます)。

3ds Max の Biped 作成オプションを使用して作成されたスケルトンをエク
スポートする方法については、3ds Max で Biped を作成してエクスポート
する (136 ページ)を参照してください。

4 Skeleton A 全体を領域選択します。

Y 軸の負の方向を向いた状態の Biped

5 アプリケーションメニューから[書き出し] > [選択を書き出し]を選択しま
す。

ヒント: [書き出し]にマウスを合わせてしばらく待つと(クリックはしませ
ん)、[書き出し]のオプションメニューが表示されます。そのオプションメ
ニューから[選択を書き出し]を選択してください。

6 [書き出すファイルを選択]ダイアログボックスで、MotionBuilder のデフォ
ルトのルートディレクトリのTutorialsフォルダに移動します。ファイルに
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My_bone_skeletonと名前を付け、ファイルの種類は Autodesk (*FBX) を選
択して、[保存]をクリックします。

注: 場所を指定しないと、ファイルは自動的に 3ds Max Export フォルダに
FBX フォーマットで保存されます。

[FBX エクスポート]ダイアログボックスが開きます。ここで、3ds Max シー
ンデータの変換方法を指定します。

[FBX エクスポート]ダイアログ ボックス

7 [FBX エクスポート]ダイアログボックス > [含める] > [アニメーション]ロー
ルアウトで、[アニメーション]をオフにします。

ここではスケルトンのみをエクスポートしたいため、アニメーションはエ
クスポートしません。
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[アニメーション]オプションをオフにした[FBX エクスポー
ト]ダイアログ ボックス

8 [メディアを埋め込む]ロールアウトを展開し、[メディアを埋め込む]もオフ
になっていることを確認します。オンになっている場合は、オフにします。
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[メディアを埋め込む]オプションをオフにした[FBX エク
スポート]ダイアログ ボックス

[メディアを埋め込む]オプションは、キャラクタと一緒にメッシュもエクス
ポートする場合にのみオンにします。このオプションをオンにすると、キャ
ラクタに関連付けられているテクスチャマップも FBX ファイルに保存され
ます。通常は、メッシュもスケルトン上にスキニングした状態で一緒にエ
クスポートします。しかし、このチュートリアルではスケルトンのみをエ
クスポートしたいため、このオプションはオフにします。

9 [拡張オプション] > [軸変換]と展開し、[Up 軸]が[Y-up]に設定されているこ
とを確認します(次の図を参照)。
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[Up 軸]を選択した[軸変換]ロールアウト

これで、エクスポート後のキャラクタには Y-up 軸が割り当てられます。
MotionBuilder では、オブジェクトの垂直方向を Y 軸で定義します。一方、
3ds Max ではオブジェクトが[Z-up]に設定されているため、[Y-up]を設定す
る必要があります。

10 [OK]をクリックすると、Skeleton A が指定のフォルダに FBX ファイルとし
てエクスポートされます。

スケルトンのエクスポートが完了したら、次のチュートリアルではこの FBX
ファイルを使用して 3ds Max のスケルトンを MotionBuilder にインポート
します。なお、FBX ファイルフォーマットでエクスポートしたスケルトン
は、他のオートデスクソフトウェア製品(Autodesk Maya など)にもインポー
トできます。

3ds Max のスケルトンを MotionBuilder にインポート
してキャラクタライズする

ここでは、前の手順(3ds Max のスケルトンをエクスポートする (122 ページ))で
保存したスケルトン(My_bone_skeleton.FBX)を MotionBuilder にインポートし
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て、アニメートできるようにキャラクタライズします。スケルトンをキャラクタ
ライズすると、スケルトンのボーンにコントロールリグが割り当てられます。
ここでは、キャラクタライズとはスケルトンをリギングすることを意味します。

注: 前の手順を省略した場合は、システム上の MotionBuilder ディレクトリ内
の Tutorials フォルダにある bone_skeleton.FBX ファイルを使用してください。

3ds Max の標準的なスケルトンを MotionBuilder にインポートするには:

1 MotionBuilder を起動します。

2 MotionBuilder のメインメニューから File > Open を選択します

3 Open File ウィンドウで、My_bone_skeleton.FBXファイルが保存されている
ディレクトリに移動してこのファイルを選択し、Open をクリックします。

注: 前の手順を省略した場合は、MotionBuilder のルートディレクトリの
Tutorials フォルダにある bone_skeleton.FBX ファイルを開きます。

4 FBX Plug-in Import Options ダイアログボックスで、デフォルトの設定の
まま Open をクリックします。

これで、3ds Max のボーンシステムのスケルトンが MotionBuilder にロー
ドされます。

3ds Max のスケルトンが Viewer ウィンドウに表
示されます。
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スケルトンをキャラクタライズするには:

1 MotionBuilder の Asset Browser でTemplates > Characters を展開し、
Character アセットをスケルトンのいずれかのボーン上へドラッグし
ます。

アセットをボーンにドラッグすると、ボーンがハイライト表示されま
す。

2 表示されるメニューで Characterize をクリックします。

キャラクタが T-スタンスポーズをとり、Z 軸の正の方向(3ds Max で
は Y 軸の負の方向に相当。.max ファイルを FBX フォーマットでエク
スポートした際に変換しました)を向いている必要があることを警告す
るダイアログボックスが表示されます。
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キャラクタライズするキャラクタは T-スタンス ポーズで
なければなりません。

3 表示される Character ダイアログボックスで Biped をクリックして、
キャラクタに適用するリグのタイプを指定します。

これで、スケルトンがキャラクタライズされました。つまり、アニメー
トできるコントロールリグを設定できるようになりました。

4 Character Controls ウィンドウで、Edit > Control Rig Input を選択
します。
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Character Controls Edit メニュー

後でキャラクタにキーフレームを設定するためには、Control Rig Input
設定を使用する必要があります。

Create Control Rig ダイアログボックスが表示されます。

5 FK/IK をクリックします。

FK と IK は、キャラクタをアニメートするときに一般的に使用される
手法です。

6 Character Controls ウィンドウの Active 領域で、Ctrl Rig In オプショ
ンをオンにします。
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Ctrl Rig In オプションがオンの状態

この設定により、コントロールリグおよび Character Controls ウィ
ンドウのオプションの左側のキャラクタ表示が有効になります。キャ
ラクタ表示は、Biped スケルトンを人間の形をしたイメージで表した
ものです。キャラクタ表示には、コントロールリグのアニメートに使
用できるすべてのエフェクタが表示されます。
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IK/FK コントロール リグが設定されたスケルトン

これでキャラクタのリギングが完了し、アニメートできる状態になり
また。

注: キャラクタのリギングを 3ds Max 側で FK/IK コンストレイントを
使って行うには、より多くの手間がかかります。

7 キャラクタ表示で、右手首のエフェクタを選択します。
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右手首のエフェクタが選択された状
態

8 Viewer ウィンドウ内でクリックし、T キーを押します。

座標変換ハンドルが表示されます。

9 次の図のように、手を下へ動かします。
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手を動かすと腕が伸び、それに合わせて体の他の部分も自然に動きま
す。

これで、キャラクタライズしたスケルトンを変形することができるよ
うになりました。

注: この手順の結果を確認したい場合は、bone_skeleton_characterized.FBX
ファイルを開いてください。

3ds Max の Biped
このチュートリアルでは、3ds Max で Biped システムを使用してスケルトンを
作成し、そのスケルトンを MotionBuilder でアニメートするためにエクスポー
トする方法を説明します。
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このチュートリアルの結果のアセット:

■ biped.FBX

注: チュートリアル用のアセットは、Asset Browser の Tutorials フォルダ(または
システム上の MotionBuilder ディレクトリ内の Tutorialsフォルダ)にあります。

3ds Max で Biped を作成してエクスポートする
ここでは、3ds Max で Biped を作成し、MotionBuilder 用にエクスポートする
方法を説明します。

3ds Max で Biped を作成し、MotionBuilder 用にエクスポートするには:

1 3ds Max を起動します。

2 アプリケーションメニューから[リセット]を選択してシーンと設定をクリ
アします。

3 [作成]パネルで[システム]を選択します。

[作成]パネルで[システム]が選択された状態

4 [オブジェクトタイプ]ロールアウトで[Biped]をクリックします。

5 パースペクティブビューポートをクリックしてドラッグし、Biped オブジェ
クトを作成します。
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注: ここでは Biped のサイズは重要ではありません。

3ds Max の Biped オブジェクト

6 [作成]パネルで[モーション]を選択します。

7 Biped のいずれかのボーンを選択してから、[モーション]パネル > [Biped]
ロールアウトで[フィギュアモード]をクリックします。
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[フィギュア モード]が選択された状態

8 [構造]ロールアウト > [ボディタイプ]領域 > [首のリンク]スピナーボックス
に 10と入力します。

首に 10 個のリンクを持つ Biped

3ds Max Biped オブジェクトの首に 10 個のリンクが設定されました(次の
図を参照)。
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首に 10 個のリンクを持つ 3ds Max
Biped オブジェクト

ヒント: MotionBuilder には首のリンク用のチャンネルが 10 個あるため、
試しにそれらのチャンネルをすべて使用する Biped を作成しましょう。

9 [脊椎のリンク]スピナーボックスに 10、[指]スピナーボックスに 5、[指の
リンク]スピナーボックスに 3、[足の指]スピナーボックスに 5、[足の指の
リンク]スピナーボックスに 3 と入力します。

10 [モーション]パネル > [Biped]ロールアウトに移動し、[フィギュアモード]
をもう一度クリックして入力モードを終了します。

11 アプリケーションメニューから[書き出し] > [書き出し]を選択します。

12 [書き出すファイルを選択]ダイアログボックスで、MotionBuilder のデフォ
ルトのルートディレクトリのTutorialsフォルダに移動します。ファイルに
My_bipedと名前を付け、ファイルの種類は Autodesk (*FBX) を選択して、
[保存]をクリックします。

13 [FBX エクスポート]ダイアログボックスで[OK]をクリックします。
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これで、Biped が FBX ファイルとして保存されます。次のチュートリアル(3ds
Max の Biped を MotionBuilder にインポートしてキャラクタライズする (140
ページ))では、この FBX ファイルを使用して Biped を MotionBuilder にイン
ポートし、キャラクタライズします。

FBX ファイルフォーマットでエクスポートした Biped は、他のオートデスク製
品(Autodesk Maya など)にインポートできます。

注: この手順の結果を確認したい場合は、biped.FBXファイルを開いてください。

3ds Max の Biped を MotionBuilder にインポートして
キャラクタライズする

以下の手順では、前の手順(3ds Max で Biped を作成してエクスポートする (136
ページ))で保存した 3ds Max の Biped (My_biped.FBX)を MotionBuilder にイン
ポートしてアニメートできる状態にします。Biped をキャラクタライズすると、
Biped のボーンにコントロールリグが割り当てられます。ここでは、キャラク
タライズとは Biped スケルトンをリギングすることを意味します。

注: 前の手順を省略した場合は、システム上の MotionBuilder ディレクトリ内
の Tutorials フォルダにある biped.FBX ファイルを使用してください。

3ds Max の Biped を MotionBuilder にインポートするには:

1 MotionBuilder を起動します。

2 MotionBuilder のメインメニューから File > Open を選択します

3ds Max を FBX ファイルフォーマットにエクスポートしているため、
MotionBuilder で開くことができます。

3 Open File ダイアログボックスで、前の手順(3ds Max で Biped を作成して
エクスポートする (136 ページ))で作成した My_biped.FBX ファイルを選択し
て Open をクリックします。

注: 前の手順を省略した場合は、MotionBuilder ルートディレクトリ内の
Tutorials フォルダにある biped.FBX ファイルを開きます。

4 FBX Plug-in Import Options ダイアログボックスで Open をクリックしま
す。
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5 Viewer ウィンドウ内にカーソルを置き、A キーを押して Biped スケルトン
全体をフレームします。

3ds Max の Biped を MotionBuilder にインポートした状態

3ds Max Biped をキャラクタライズするには:

1 Asset Browser で Templates > Characters を展開し、3ds Max Biped
Template をスケルトンの上にドラッグします。
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Biped スケルトンに 3ds Max Biped Template アセットを適用します。

3ds Max Biped Template は、3ds Max で作成された Biped 専用のテンプ
レートです。3ds Max Biped の命名規則はそのままでは MotionBuilder で
認識できないため、このテンプレートを使用する必要があります。

2 表示されるメニューで Characterize をクリックします。

これで、Biped スケルトンがキャラクタライズされました。次の手順では
コントロールリグを追加して、この Biped スケルトンをアニメートできる
ようにします。

3 Character Controls ウィンドウで、Edit > Control Rig Input を選択しま
す。
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Character Controls Edit メニュー

Biped をアニメートするためには、Control Rig Input 設定を使用する必要
があります。

4 Create Control Rig ダイアログボックスで FK/IK をクリックします。

FK と IK は、キャラクタをアニメートするときに一般的に使用される手法
です。

5 Character Controls ウィンドウの Active 領域で、Ctrl Rig In をオンにしま
す(A)。

Ctrl Rig In をオンにすると、Character Controls ウィンドウのキャラクタ
表示が有効になります。また、Viewer ウィンドウには Biped のコントロー
ルリグエフェクタが表示されます(B)。
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A. Ctrl Rig In をオンにします。B. Biped 上にコントロー
ル リグ エフェクタが表示されます。

キャラクタ表示は、Biped スケルトンを人間の形をしたイメージで表した
ものです。キャラクタ表示には、コントロールリグのアニメートに使用で
きるすべてのエフェクタが表示されます。これで Biped のリギングが完了
し、アニメートできる状態になりました。

注: キャラクタのリギングを 3ds Max 側で FK/IK コンストレイントを使っ
て行うには、より多くの手間がかかります。

6 キャラクタ表示で、右手首のエフェクタを選択します。

右手首のエフェク
タが選択された状
態
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7 Viewer ウィンドウ内でクリックし、T キーを押します。

座標変換ハンドルが表示されます。

8 次の図のように、手を下へ動かします。

手を動かすと腕が伸び、それに合わせて体の他の部分も自然に動きます。

これで、キャラクタライズした 3ds Max Biped を変形およびアニメートす
ることができるようになりました。3ds Max のキャラクタを MotionBuilder
でアニメートする (153 ページ)を参照してください。

3ds Max のキャラクタ
このチュートリアルでは、3ds Max で作成された、スケルトンがバインドされ
たスキンキャラクタを FBX ファイルフォーマットでエクスポートし、
MotionBuilder にインポートしてキャラクタライズする(アニメートできる状態
にする)方法を説明します。

エクスポートするキャラクタは、スケルトンにスキンとテクスチャを適用したも
のです。したがって、手順は 3ds Max のスケルトンや Biped スケルトンをエク
スポートするチュートリアルと似ています。

このチュートリアルで使用するアセット:

■ Pepe.max
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このチュートリアルの結果のアセット:

■ Pepe.FBX

■ Pepe_rigged.FBX

注: チュートリアル用のアセットは、Asset Browser の Tutorials フォルダ(または
システム上の MotionBuilder ディレクトリ内の Tutorialsフォルダ)にあります。

3ds Max のキャラクタをエクスポートする
以下の手順では、3ds Max キャラクタを MotionBuilder にエクスポートする方
法について説明します。

3ds Max のキャラクタ Pepe をエクスポートするには:

1 3ds Max を起動します。

2 アプリケーションメニューから[リセット]を選択してシーンと設定をクリ
アします。

3 [開く]を選択し、MotionBuilder ルートディレクトリ内の Tutorials フォル
ダにある Pepe.max シーンファイルを開きます。

Pepe.maxシーンファイルが開き、メッシュで覆われた Biped スケルトンが
表示されます。
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メッシュで覆われた 3ds Max Biped スケルトン

4 アプリケーションメニューから[書き出し] > [書き出し]を選択します。

5 [書き出すファイルを選択]ダイアログボックスで、MotionBuilder のデフォ
ルトのルートディレクトリのTutorialsフォルダに移動します。ファイルに
My_Pepeと名前を付け、ファイルの種類は Autodesk (*FBX) を選択して、[保
存]をクリックします。

注: 場所を指定しないと、ファイルは自動的に 3ds Max Export フォルダに
FBX フォーマットで保存されます。

[FBX エクスポート]ダイアログボックスが開きます。ここで、3ds Max の
キャラクタを MotionBuilder で認識できる FBX ファイルに変換する方法を
指定します。

6 [FBX エクスポート]の[含める]ロールアウトで、[アニメーション]、[アニ
メーションを焼付け]、[メディアを埋め込む]の各オプションを有効にして
から、[OK]をクリックします。
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[アニメーション]、[アニメーションを焼付け]と[メディア
を埋め込む]をオンにします。

これらのオプションをオンにすると、キャラクタ Pepe と一緒にメッシュも
エクスポートして、このキャラクタに割り当てられているテクスチャとマ
テリアルをエクスポートできます。

これで、キャラクタが FBX ファイルフォーマットで保存されます。次の
チュートリアルでは、この FBX ファイルを使用してキャラクタを
MotionBuilder にインポートします(また、FBX ファイルフォーマットを
サポートしている他のプログラムにもインポートできます)。

3ds Max のキャラクタを MotionBuilder にインポート
してキャラクタライズする

以下の手順では、前の手順(3ds Max のキャラクタをエクスポートする(146ペー
ジ))で保存した My_Pepe.FBX ファイルを MotionBuilder にインポートします。
キャラクタ Pepe は、3ds Max の Biped にメッシュとマテリアルを適用したも
のです。したがって、インポートの手順は3ds Max の Biped を MotionBuilder
にインポートしてキャラクタライズする (140 ページ)と似ています。キャラクタ
をインポートしたら、キャラクタライズします。

148 | 第 10 章   MotionBuilder に 3ds Max ファイルをインポートする



注: 前の手順を省略した場合は、システム上の MotionBuilder ディレクトリ内
の Tutorials フォルダにある Pepe.FBX ファイルを使用してください。

3ds Max のキャラクタを MotionBuilder にインポートするには:

1 MotionBuilder を起動します。

2 MotionBuilder のメインメニューから File > Open を選択します

3 Open File ダイアログボックスで、3ds Max のキャラクタをエクスポート
する(146ページ)でエクスポートしたMy_Pepe.FBXファイルを選択して Open
をクリックします。続いて、FBX Plug-in Import Options ダイアログボッ
クスで Open をクリックします。

注: または、MotionBuilder のルートディレクトリの Tutorials フォルダに
ある、Pepe.FBX ファイルをインポートしても構いません。

キャラクタ Pepe が Viewer ウィンドウに表示されます。

4 Viewer ウィンドウ内にカーソルを置き、Aキーを押してキャラクタ全体を
フレームします。

3ds Max のキャラクタ Pepe を MotionBuilder にイ
ンポートした状態

キャラクタをキャラクタライズするには:

1 Viewer ウィンドウで、Ctrl+Aキーを何度か押して X-Ray モードに切り替え
ます。
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X-Ray モードでは、キャラクタのスキンの下にあるスケルトンも表示され
ます。

2 Asset Browser で Templates > Characters を展開し、3ds Max Biped
Template アセットをキャラクタ Pepe のスケルトンの上にドラッグします。

キャラクタ Pepe のスケルトンに 3ds Max Biped
Template アセットを適用します。

3ds Max Biped Template は、3ds Max で作成された Biped 専用のテンプ
レートです。3ds Max Biped の命名規則はそのままでは MotionBuilder 側
のキャラクタで認識できないため、このテンプレートを使用する必要があ
ります。

3 表示されるメニューで Characterize をクリックします。

4 Character Controls ウィンドウで、Edit > Control Rig Input を選択しま
す。
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Character Controls Edit メニュー

Biped にキーフレームアニメーションを適用するためには、Control Rig
Input 設定を使用する必要があります。

5 Create Control Rig ダイアログボックスで FK/IK をクリックします。

FK と IK は、キャラクタをアニメートするときに一般的に使用される手法
です。

6 Character Controls ウィンドウの Active 領域で、Ctrl Rig In をオンにしま
す。

Biped 上にエフェクタが表示されます(次の図を参照)。

A. Ctrl Rig In をオンに設定 B. キャラクタ上にエフェクタが表示される
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この操作により、コントロールリグがアクティブになり、Character
Controls のキャラクタ表示が有効になります。キャラクタ表示は、キャラ
クタのスケルトンを人間の形をしたイメージで表したものです。キャラク
タ表示には、コントロールリグのアニメートに使用できるすべてのエフェ
クタが表示されます。これで Biped のリギングが完了し、アニメートでき
る状態になりました。

注: キャラクタのリギングを 3ds Max 側で FK/IK コンストレイントを使っ
て行うには、より多くの手間がかかります。

7 キャラクタ表示で、右手首のエフェクタを選択します。

右手首のエフェクタが選択された状態

8 Viewer ウィンドウ内でクリックし、T キーを押します。

座標変換ハンドルが表示されます。

9 次の図のように、手を下へ動かします。

手を動かすと腕が伸び、それに合わせて体の他の部分も自然に動きます。
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これで、モーションキャプチャやキーフレームアニメーションを使用して
キャラクタをアニメートできる状態になりました。

10 MotionBuilder のルートディレクトリの Tutorials フォルダに、
My_Pepe_rigged.FBX と名前を付けて保存します。

注: このファイルを使用して、次のチュートリアルを行います(あるいは、システ
ム上の MotionBuilder ルートディレクトリ内の Tutorials フォルダにある
Pepe_rigged.FBX ファイルを使用してもかまいません)。

3ds Max のキャラクタを MotionBuilder でアニメートする(153ページ)を参照し
てください。

3ds Max のキャラクタを MotionBuilder でアニ
メートする

MotionBuilder でキャラクタをアニメートするには 2 通りの方法があります。1
つは手動でキーフレームを設定する方法、もう 1 つはモーションキャプチャ
データを使用する方法です。このチュートリアルでは、3ds Max のキャラクタ
(145ページ)のセクションでインポートした 3ds Max キャラクタ Pepeをアニメー
トする方法を説明します。

注: 前のセクション(3ds Max のキャラクタを MotionBuilder にインポートして
キャラクタライズする (148 ページ))の手順を省略した場合は、システム上の
MotionBuilder ルートディレクトリ内の Tutorialsフォルダにある Pepe_rigged.FBX
ファイルを使用してください。

まずは、MotionBuilder に付属しているモーションキャプチャファイルの 1 つ
を使って Pepeをアニメートします(モーションキャプチャデータを使用してキャ
ラクタをアニメートする(154ページ))。その次のチュートリアル(キーフレームを
追加してキャラクタをアニメートする(160ページ))で、キーフレームを使用して
アニメーションを仕上げます。

注: MotionBuilder でキャラクタをアニメートする方法をご存知の方は、このセ
クションは省略してかまいません。

このチュートリアルで使用するアセット:

■ Pepe_rigged.FBX
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■ Iceslip.fbx

このチュートリアルの結果のアセット:

■ Pepe_Mocap.FBX

■ Pepe_keyanim.FBX

注: チュートリアル用のアセットは、Asset Browser の Tutorials フォルダ(または
システム上の MotionBuilder ルートディレクトリ内の Tutorials フォルダ)にあ
ります。

まだ MotionBuilder を使い慣れていない方は、まず MotionBuilder のキーボー
ドショートカットを使用した操作を練習しましょう。

■ Ctrl+Shift キーを押しながらドラッグしてシーンをオービットする

■ Ctrl キーを押しながらドラッグしてシーンをズームイン/アウトする

■ Shift キーを押しながらドラッグしてシーンをパンする

注: このチュートリアルの手順では MotionBuilder のキーボードショートカッ
トを使用していますが、3ds Max のキーボードショートカットを使用すること
もできます。その場合は、MotionBuilder のメニューバーから Settings >
Keyboard Configuration > 3ds Max を選択してください。MotionBuilder Help
の「キーボードショートカット」の「3ds max キーボードショートカット」
に、3ds Max のキーボードショートカットの一覧があります。

モーションキャプチャデータを使用してキャラクタ
をアニメートする

次の手順では、MotionBuilder キーフレームアニメーションのテクニックを用
いてモーションキャプチャアニメーションを微調整する方法を学びます。

前のセクション(3ds Max のキャラクタを MotionBuilder にインポートしてキャ
ラクタライズする(148ページ))の手順を省略した場合は、MotionBuilder のルー
トディレクトリの Tutorials フォルダにある Pepe_rigged.FBX ファイル(または、
Asset Browser の Tutorials フォルダの Pepe_rigged アセット)を使用してくださ
い。
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モーション キャプチャ データを使用してキャラクタ Pepe をアニメートするに
は:

1 MotionBuilder を起動します。

2 Asset Browser の Tutorials フォルダの My_Pepe_rigged アセット(前のセク
ション(3ds Max のキャラクタを MotionBuilder にインポートしてキャラ
クタライズする (148 ページ))の最後の手順で保存した My_Pepe_rigged.FBX
ファイル)を Viewer ウィンドウにドラッグします。

注: 前のセクション(3ds Max のキャラクタを MotionBuilder にインポート
してキャラクタライズする(148ページ))の手順を省略した場合は、Pepe_rigged
アセット(Pepe_rigged.fbx ファイル)を Viewer ウィンドウへドラッグしてく
ださい。

3 FBX Open > No Animation を選択します。

キャラクタ Pepe が Viewer ウィンドウに表示されます。

ファイルのロード A. Asset Browser の Pepe_rigged アセット B. シーン
に Pepe がロードされる

4 Viewer ウィンドウの空の領域をクリックし、A キーを押して全体をフレー
ムし、キャラクタ Pepe にズームインします。
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5 Ctrl+Aキーを何度か押して X-Ray モードに切り替えると、Pepe のスケルト
ンとコントロールリグが表示されます。

X-Ray モードで表示した Pepe のコントロール リグ

6 Ctrl+Shift キーを押しながらドラッグしてシーンをオービットし、キャラク
タ Pepe の右側面を表示します。次の図を参考にしてください。

Pepe をオービットします。

7 Asset Browser > Tutorials フォルダで IceSlip アセット(IceSlip.fbx ファイル)を
選択し、Viewer ウィンドウの空の領域にドラッグします。

8 FBX Merge > IceSlip を選択します。

Pepe のシーンにモーションキャプチャデータ(大きな黄色いスケルトン)が
マージされます。
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9 黄色いスケルトンが表示されるまで、シーンをズームアウト(Ctrl キーを押
しながら左下へドラッグ)します。

Pepe と、モーション キャプチャ データを持つスケルトン

10 Transport Controls の Play ボタンをクリックして、黄色いスケルトン IceSlip
のアニメーションを再生します。

Transport Controls の Play ボタン

11 Character Controls > Current Character メニューで、キャラクタリスト
に PEPE と表示されていることを確認します。
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12 Character Controls で Edit > Input > Skeleton2 を選択します(「Skeleton2」
は、モーションキャプチャアニメーションを持つ黄色いスケルトンの名前
です)。

Pepe はスケルトンの姿勢になります(次の図を参照)。
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13 Transport Controls のタイムラインインジケータをドラッグしてアニメー
ションをスクラブします。あるいは、J キーを押しながら Viewer ウィンド
ウ内を左右にドラッグする方法もあります。

これで、スケルトンのアニメーションがキャラクタ Pepeを駆動するように
なりました。

14 Pepe だけが表示されるようになるまで Ctrl+Aキーを何度か押し、フレーム
92 に移動して Pepe にズームインします。

15 Ctrl+Shift キーを押しながらドラッグして Pepe をオービットします。

注意して見ると、Pepe の片方の手が顔を貫通してしまっていることが分か
ります。
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モーション キャプチャが原因で、手の動きに問題が
生じている状態

16 問題の動きを確認できるまで、アニメーションを何度かスクラブしてみて
ください。

Pepe のボーンの動きをコントロールするアニメーションが、生理学的に
まったく異なるスケルトンをベースにしているためです。たとえば、Pepe
の頭や手足は黄色いスケルトンと比べるとかなり大きく、肩ははるかに小
さいことが分かります。

17 ファイルを My_Pepe_Mocap.fbx という名前で保存します。

次の手順では、このファイルにキーフレームを追加して、Pepe の手の動き
を修正します。

キーフレームを追加してキャラクタをアニメートする
MotionBuilder では、キャラクタに手動でキーフレームを設定することでキャ
ラクタをアニメートできます。この方法は、オリジナルのアニメーションを作成
する場合や、モーションキャプチャアニメーションに修正を加えたい場合に役
立ちます。

以下の手順では、キーフレームアニメーションを使用してモーションキャプチャ
アニメーションを微調整します。

注: MotionBuilder でキャラクタにキーフレームを設定する方法をご存知の方
は、以下の手順は省略してかまいません。
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キーフレームを使用してモーション キャプチャ アニメーションを微調整するに
は:

1 前の手順(モーションキャプチャデータを使用してキャラクタをアニメー
トする(154ページ))で Pepeにモーションキャプチャデータを適用した結果
のファイル(My_Pepe_Mocap.fbx)を開きます。

前の手順を省略した場合は、Pepe_Mocap.fbx ファイルを開いてください。

2 Character Controls のキャラクタ表示で、右手首のエフェクタをクリック
します。

右手首のエフェクタが選択された状態

3 Viewer ウィンドウ内でクリックし、T キーを押します。

座標変換ハンドルは表示されません。

4 Pepe の手を動かしてみてください。

手は動かないはずです。それは、Pepe のアニメーションは、コントロール
リグではなくスケルトンによってコントロールされているためです。Pepe
のモーションキャプチャアニメーションにキーフレームを設定するには、
まずスケルトンのアニメーションを Pepe のコントロールリグ上にプロッ
ト(ベイク)する必要があります。

5 Character Controls ウィンドウで、Edit > Plot Character を選択します。
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Character Controls ウィンドウの Edit メ
ニューで Plot Character を選択します。

6 Character ダイアログボックスで Control rig をクリックします。

Character ダイアログボックスが表示されます。
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Character ダイアログ ボックス

7 Plot をクリックします。

Plot コマンドでは、アニメーショントラックのベースレイヤ(または
BaseAnimation layer)で各フレームごとに 1 つずつキーが作成されるため、
編集がしづらくなります。(Pepe の手首のエフェクタを選択している場合
は、作成されたキーフレームが Transport Controls に表示されます)。

これで、キャラクタ Pepeをコントロールリグを使って編集できるようにな
りました。

8 Key Controls で Layer メニューをクリックし、AnimLayer1 を選択しま
す。

キーフレームを追加するために
AnimLayer1 を選択します。
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アニメーションレイヤを選択すると、オリジナルのアニメーションを
BaseAnimation レイヤに保持したまま、アニメーションを編集できます。
AnimaLayer1 を選択すると、BaseAnimation レイヤに設定されているキー
フレームが非表示になり、AnimLayer1 レイヤに設定されているキーフレー
ムが表示されます(現時点では何も設定されていません)。

9 フレーム 80 (問題のある右手の動きが始まるタイミング)に移動します。
Character Controls ウィンドウのキャラクタ表示で右手首のエフェクタを
クリックした後、Key Controls で Key をクリックします。

注: K キーを押してキーフレームを設定することもできます。

10 フレーム 105 (問題の手の動きが終わるタイミング)に移動して、もう 1 つ
キーを設定します。

以降の手順を実行しても、最初のキーより前および 2 番目のキーの後は、
キャラクタの動きは何も変化しません。フレーム 80 からフレーム 105 ま
での動きだけを修正します。

11 フレーム 94 (設定した 2 つのキーフレームの中間)に移動します。

12 Viewer ウィンドウで T キーを押し、Pepe の手を X 軸と Z 軸に沿って移動
して顔から遠ざけてから(次の図を参照)、キーを設定します。
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Pepe の手を顔から遠ざけます。

13 Jキーを押しながら前後にドラッグして、キーを作成したことでキャラクタ
の手がどのように反応するかを確認します。

14 必要に応じて、手の動きにさらに修正を加えます。調整するたびにキーを
作成するのを忘れないでください。

15 アニメーションの最後のフレームに移動し、Pepe の体の右側が表示される
ようにビューを調整します。

キャラクタの右手が頭に近すぎます。

16 Pepe の手を体から離して、キーを設定します。

17 Rキーを押して、キー回転リングを使って手の位置を修正します。手が地面
と変更になったら、さらにキーを設定します。
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注: 必要に応じてビューを調整して、Pepe の手が地面の高さと一致してい
るかどうか確認してください。

回転リングを使って右手の位置を調整します。

18 アニメーションを再生して結果を確認します。

19 さらにキャラクタの体の位置を調整してから、ファイルを
My_Pepe_keyanim.fbx という名前で保存します。

この FBX ファイルをエクスポートして 3ds Max にインポートし直すため
には、アニメーションをベイクする必要があります。キャラクタをエクス
ポートしてアニメーションを 3ds Max にインポートし直す (166 ページ)を
参照してください。

キャラクタをエクスポートしてアニメーション
を 3ds Max にインポートし直す

MotionBuilder ではコントロールリグを使用してキャラクタアニメーションを
定義しますが、3ds Max はこのコントロールリグ情報を読み取ることができま
せん。そこで、アニメーションデータをキャラクタのスケルトンにプロット(「ベ
イク」とも呼ばれます)する必要があります。

このチュートリアルでは、以下の方法について説明します。

■ 3ds Max にエクスポートするアニメーションをベイクする (167 ページ)
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■ MotionBuilder のシーンファイルを 3ds Max にインポートする(169ページ)

このチュートリアルで使用するアセット:

■ Pepe_keyanim.FBX

このチュートリアルの結果のアセット:

■ Pepe_plotted.FBX

■ Pepe_plotted.max

3ds Max にエクスポートするアニメーションをベイク
する

ここでは、キャラクタアニメーションを 3ds Max にインポートし直すために、
アニメーションをキャラクタにプロットする方法を説明します。

アニメーションをキャラクタ Pepe のスケルトンにベイクするには:

1 MotionBuilder を起動します。

2 前の手順(キーフレームを追加してキャラクタをアニメートする(160ページ))
で保存した結果ファイル、My_Pepe_keyanim.fbx を開きます。

前の手順を省略した場合は、Pepe_keyanim.fbxファイルを開いてください。

3 Character Controls で、Edit > Plot Character を選択します。

4 Character ダイアログボックスで Skeleton をクリックします。

5 続いて表示されるもう 1 つの Character ダイアログボックスで、デフォル
トの設定(次の図を参照)のまま Plot をクリックします。
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Character ダイアログボックスのデフォ
ルトの設定

キャラクタのコントロールリグは無効になりますが、キャラクタ Pepe の
アニメーション情報はすべて保持されます。

アニメーションをプロットした後でキャラクタの動きを編集する場合は、
もう一度 Character Control で、Edit > Plot Character > Control Rig を選
択します。編集が終わったら、手順 3 と 5 を繰り返して、アニメーション
をキャラクタのスケルトンにベイクし直します。

注: この状態でファイルを保存すると、シーンにはキャラクタ Pepe のアニ
メーションと一緒に黄色いリファレンススケルトンも保存されます。必要
であればシーンからスケルトンを削除したり、キャラクタ Pepe だけを選択
して別のファイルに保存し、そのファイルを 3ds Max にインポートするこ
とも可能です。ただし、3ds Max にインポートする際にスケルトンを削除
する方が簡単です。

6 MotionBuilder のメインメニューから File > Save As を選択して
MotionBuilder のルートディレクトリの Tutorials フォルダに移動し、
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My_Pepe_plottedと名前を付けて Save をクリックし、Tutorialsフォルダに
ファイルを保存します。

MotionBuilder のシーンファイルを 3ds Max にイン
ポートする

FBX プラグインを使用すれば、MotionBuilder で保存したシーンの全内容をイ
ンポートすることも、3ds Max シーンのエレメントと名前が一致するエレメン
トだけをインポートすることもできます。

なお、3ds Max では、MotionBuilder からインポートしたアニメーションを自
由に編集できます。

アニメートしたキャラクタを 3ds Max にインポートするには:

1 3ds Max を起動します。

2 アプリケーションメニューから[リセット]を選択してシーンと設定をクリ
アします。

3 アプリケーションメニューから[読み込み] > [読み込み]を選択します。

4 [読み込むファイルを選択]ダイアログボックスで、MotionBuilder のルー
トディレクトリの Tutorials フォルダに移動し、前の手順の実行結果の
My_Pepe_plotted.FBX ファイルを開きます (3ds Max にエクスポートするア
ニメーションをベイクする (167 ページ))。

前の手順を省略した場合は、Pepe_plotted.fbx ファイルを開いてください。

[FBX インポート]ダイアログボックスが表示されます。
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[FBX インポート]ダイアログ ボックス

5 [FBX インポート]ウィンドウで、[含める]ロールアウトが表示されるまで下
方向にスクロールし、展開します(展開されていない場合)。

[ファイル内容]リストには、デフォルトでは[シーンの要素を追加して更新]
が表示されます。このデフォルトの設定では、キャラクタ Pepe と一緒に黄
色いリファレンススケルトンもインポートされます。[シーンの要素を更新]
オプションを選択した場合は、インポートしたファイルのシーンエレメン
トと同じ名前の 3ds Max シーンエレメントだけが更新されます。

6 MotionBuilder のアニメーションを新規 3ds Max シーンにインポートする
ために、[シーンに追加]オプションを選択します。
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7 OK をクリックします。

8 [スキン]モディファイヤのインポートに関する[Warning and Errors]ダイア
ログボックスが表示されたら、[OK]をクリックします。

9 パースペクティブビューポートで Pepe にズームインし、タイムラインを
スクラブして、MotionBuilder で作成したアニメーションがキャラクタ
Pepe のボーンにベイクされていることを確認します。

注: ビューポートを見やすくするために、黄色いスケルトンを領域選択し、
右クリックしてクアッドメニューを表示します。クアッドメニューから[選
択を非表示]を選択すると、スケルトンが非表示になります。
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MotionBuilder のアニメーションを 3ds Max にインポー
トした結果

これで、MotionBuilder で作成したアニメーションを 3ds Max にインポー
トできました。

まとめ

この一連のチュートリアルでは、まず 3ds Max で作成された数種類のスケルト
ンを FBX ファイルとしてエクスポートし、MotionBuilder にインポートしまし
た。その後、MotionBuilder でボーンをキャラクタライズし、キャラクタをス
ケルトンにプロットしてアニメートしました。

さらに、アニメーションを Pepe のコントロールリグにベイクし、モーションを
微調整してからアニメーションを Pepe のスケルトンにベイクし直して、再度
3ds Max にインポートしました。
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用語集

この用語集では、MotionBuilder 特有の用語のほか、3D 業界でよく使用される
CG およびソフトウェア関連の用語について説明します。

また、MotionBuilder で用いられる頭字語と、2D/3D 関連の一般的な頭字語も
紹介します。

頭字語
以下は、『MotionBuilder ヘルプ』で使用されている頭字語の一覧です。

■ BCC (186 ページ)

■ BCS (187 ページ)

■ BVH (187 ページ)

■ FK (189 ページ)

■ fps (189 ページ)

■ HSB (190 ページ)

■ HUD (190 ページ)

■ IK (190 ページ)

■ NTSC (National Television System Committee) (191 ページ)

■ NURBS (Non Uniform Rational B-splines) (192 ページ)

■ PAL (193 ページ)

■ Qt (193 ページ)

■ SMPTE (194 ページ)
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■ TCB (Tension、Continuity、Bias) (195 ページ)

■ UCS (195 ページ)

■ UV (195 ページ)

■ VTR (Video Tape Recorder) (196 ページ)

■ WCS (196 ページ)

用語
このセクションでは、MotionBuilder 特有の用語のほか、3D 業界でよく使用さ
れる CG およびソフトウェア関連の用語の一覧と解説をまとめました。

用語リスト
以下に、MotionBuilder 特有の用語と、3D 業界でよく使用される CG およびソ
フトウェア関連の用語の一覧を示します。

英数字
■ .fbx (185 ページ)

■ 3D 座標空間 (186 ページ)

■ 3D マット (186 ページ)

■ Actor Face (186 ページ)

■ Back Plate (186 ページ)

■ BaseAnimation レイヤ (186 ページ)

■ BCC (186 ページ)

■ BCS (187 ページ)

■ biped (二足歩行) (187 ページ)

■ BVH (Biovision Hierarchical Data) (187 ページ)

■ BVH (187 ページ)
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■ COM ポート (187 ページ)

■ Distribution Factor (187 ページ)

■ Done 状態 (187 ページ)

■ Dopesheet (188 ページ)

■ Expression コンストレイン (188 ページ)

■ FCurve (188 ページ)

■ fill (188 ページ)

■ First Contact バルーン (188 ページ)

■ FK (フォワードキネマティクス) (189 ページ)

■ FK (189 ページ)

■ FK エフェクタ (189 ページ)

■ FK リグ (189 ページ)

■ fps (189 ページ)

■ Global キーインググループ (189 ページ)

■ Hardware FC (190 ページ)

■ HSB (190 ページ)

■ HUD (190 ページ)

■ IK (インバースキネマティクス) (190 ページ)

■ IK (190 ページ)

■ IK エフェクタ (191 ページ)

■ IK リグ (191 ページ)

■ IP アドレス (191 ページ)

■ Local キーインググループ (191 ページ)

■ Mipmap (191 ページ)

■ NTSC (National Television System Committee) (191 ページ)
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■ Null (ヌル) (192 ページ)

■ NURBS (Non Uniform Rational B-splines) (192 ページ)

■ NURBS (Non Uniform Rational B-splines) (192 ページ)

■ Object キーインググループ (192 ページ)

■ OpenGL (193 ページ)

■ Optical エディタ (193 ページ)

■ PAL (193 ページ)

■ Phase Alternating Line (PAL) (193 ページ)

■ Qt (193 ページ)

■ quadruped (四足歩行) (194 ページ)

■ Relation (194 ページ)

■ Relation コンストレイン (194 ページ)

■ SMPTE (194 ページ)

■ SteeringWheels (194 ページ)

■ TCB (Tension、Continuity、Bias) (195 ページ)

■ Timecode (195 ページ)

■ T-スタンス (195 ページ)

■ UCS (195 ページ)

■ Up ベクトル (195 ページ)

■ UV (195 ページ)

■ ViewCube (196 ページ)

■ VK Ripple (196 ページ)

■ VTR (Video Tape Recorder) (196 ページ)

■ WCS (196 ページ)

■ X 座標 (196 ページ)
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■ X 軸 (196 ページ)

■ Y 座標 (196 ページ)

■ Y 軸 (197 ページ)

■ Z 座標 (197 ページ)

■ Z 軸 (197 ページ)

あ行
■ アーティファクト (197 ページ)

■ アクター (197 ページ)

■ アセット (197 ページ)

■ 値 (198 ページ)

■ アニメーション (198 ページ)

■ アルファチャンネル (198 ページ)

■ アルファブレンド (198 ページ)

■ アンチエイリアシング (198 ページ)

■ 安定化オブジェクト (199 ページ)

■ 移動(translation) (199 ページ)

■ 色信号の交雑 (199 ページ)

■ 色タイミング (199 ページ)

■ 色の交雑 (199 ページ)

■ ウェイト付けされた接線 (199 ページ)

■ ウェイト付けのない接線 (200 ページ)

■ エイリアシング (200 ページ)

■ エクスプレッション (200 ページ)

■ エフェクタ (200 ページ)

■ エレメント (200 ページ)
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■ オクルージョン (201 ページ)

■ オブジェクトのブレンド(blending object) (201 ページ)

か行
■ 階層 (201 ページ)

■ 回転(rotation) (201 ページ)

■ ガイドポーズ (201 ページ)

■ カスタムキーインググループ (202 ページ)

■ カット (202 ページ)

■ カメラ (202 ページ)

■ カメラの注視点 (202 ページ)

■ カラーバースト (202 ページ)

■ カレントセグメント (202 ページ)

■ 環境マッピング(Environment mapping) (203 ページ)

■ 観察点 (203 ページ)

■ キー (203 ページ)

■ キーインググループ (203 ページ)

■ キーフレーム (203 ページ)

■ キーフレーム操作 (203 ページ)

■ 基点 (203 ページ)

■ 輝度 (204 ページ)

■ 輝度キー (204 ページ)

■ ギャップ (204 ページ)

■ キャラクタ (204 ページ)

■ キャラクタアセット (204 ページ)

■ キャラクタアニメーション (204 ページ)
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■ キャラクタフェイス (205 ページ)

■ キャラクタマッピング (205 ページ)

■ キャラクタモデル (205 ページ)

■ 球体マップ (205 ページ)

■ 球面マップ (205 ページ)

■ 極ベクトル (206 ページ)

■ クォータニオン (206 ページ)

■ クラスター (206 ページ)

■ クラスターシェイプ (206 ページ)

■ クリップ (206 ページ)

■ グローバル座標 (207 ページ)

■ クロマキー (207 ページ)

■ クロミナンス (207 ページ)

■ 黒レベル (207 ページ)

■ 光学式マッピング (207 ページ)

■ 光学式ルート (207 ページ)

■ 効果の送信 (208 ページ)

■ ゴースト (208 ページ)

■ ゴースト曲線 (208 ページ)

■ 子階層 (208 ページ)

■ ゴボ (208 ページ)

■ コマンドクリップ (208 ページ)

■ コンストレイン (209 ページ)

■ コンストレインクリップ (209 ページ)

■ コンストレインされたオブジェクト (209 ページ)
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■ コントラスト (209 ページ)

■ コントロールリグ (209 ページ)

■ コンバイナ (209 ページ)

さ行
■ 彩度 (210 ページ)

■ 座標変換 (210 ページ)

■ サンプル (210 ページ)

■ シーン (210 ページ)

■ シェイプ (210 ページ)

■ シェイプ操作 (211 ページ)

■ シェーダ (211 ページ)

■ 視覚的キーフレーム (211 ページ)

■ 色相 (211 ページ)

■ 磁気マッピング (211 ページ)

■ シャドウマップ (212 ページ)

■ シャトル (212 ページ)

■ ジョイント (212 ページ)

■ ジョグ操作 (212 ページ)

■ シリアルポート (212 ページ)

■ シンプルコンストレイン(Simple Constraint) (212 ページ)

■ スキン (212 ページ)

■ スクラビング (213 ページ)

■ スケーリング (213 ページ)

■ スケルトン (213 ページ)

■ スタック (213 ページ)
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■ スタンスポーズ (213 ページ)

■ スプライン (213 ページ)

■ スワッピング (213 ページ)

■ セグメント (214 ページ)

■ 接線ハンドル (214 ページ)

■ ゼロキーフレーム (214 ページ)

■ ゼロポイント (214 ページ)

■ 全国テレビジョン方式委員会(NTSC) (214 ページ)

■ センサ (214 ページ)

■ ソースオブジェクト (215 ページ)

■ 属性 (215 ページ)

■ ソルバ (215 ページ)

た行
■ タイムワープ (215 ページ)

■ ダミーノード (215 ページ)

■ チャンネル (216 ページ)

■ 通信ポート (216 ページ)

■ テイク (216 ページ)

■ テクスチャ (216 ページ)

■ デッキ (216 ページ)

■ テッセレーション (216 ページ)

■ デバイス (217 ページ)

■ デフォーメーション (217 ページ)

■ 透明度 (217 ページ)

■ トラック (217 ページ)
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■ トリガ (217 ページ)

■ トリガグループ (217 ページ)

な行
■ ネームスペース (218 ページ)

■ ノイズ (218 ページ)

■ ノード (218 ページ)

は行
■ バースト (219 ページ)

■ 背景色消去（BCC） (219 ページ)

■ 背景色抑制（BCS） (219 ページ)

■ 背景面 (219 ページ)

■ バインドポーズ (219 ページ)

■ バウンディングボックス (219 ページ)

■ バウンドモデル (220 ページ)

■ 波形 (220 ページ)

■ バックグラウンドジェネレータ (220 ページ)

■ パッチ (220 ページ)

■ バッチ処理 (220 ページ)

■ バッファ (220 ページ)

■ パラメータ (220 ページ)

■ 反応時間 (221 ページ)

■ バンプマップ (221 ページ)

■ ピッチ (221 ページ)

■ ビットプレーン (221 ページ)

■ ピボット(基点) (221 ページ)
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■ 標準チャンネル(generic channel) (221 ページ)

■ ファンクションカーブ (222 ページ)

■ フィルタ (222 ページ)

■ フィルタ処理 (222 ページ)

■ 副搬送波 (222 ページ)

■ 不透明度 (222 ページ)

■ 部分的なオクルージョン (222 ページ)

■ ブランチ (223 ページ)

■ フレーム (223 ページ)

■ フレームレート (223 ページ)

■ プロパティ (223 ページ)

■ ペアレント(parent) (223 ページ)

■ ペアレント化(parenting) (224 ページ)

■ ベクトル (224 ページ)

■ ヘッドアップディスプレイ(HUD) (224 ページ)

■ ホイール (224 ページ)

■ ホイール (224 ページ)

■ ホイールウェッジ (224 ページ)

■ ホイールサーフェス (224 ページ)

■ ボイスチャンネル (225 ページ)

■ 法線 (225 ページ)

■ 法線マップ (225 ページ)

■ ポーズ (225 ページ)

■ ボーレート (225 ページ)

■ ボーン (225 ページ)
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■ 補外 (226 ページ)

■ 補間 (226 ページ)

■ 補助エフェクタ (226 ページ)

■ 補助ピボット (226 ページ)

ま行
■ マーカ (226 ページ)

■ マーカセット (227 ページ)

■ マッチポーズ (227 ページ)

■ マテリアル (227 ページ)

■ 密なデータ (227 ページ)

■ 明度 (227 ページ)

■ 命名テンプレート (228 ページ)

■ モアレ (228 ページ)

■ モーションキャプチャ (228 ページ)

■ モーションソース (228 ページ)

■ モーフターゲット (228 ページ)

■ モデル (228 ページ)

や行
■ ユーザ座標系(UCS) (229 ページ)

■ ユーザチャンネル (229 ページ)

■ ヨー (229 ページ)

ら行
■ ラベルなしセグメント (229 ページ)

■ リジッドボディ (229 ページ)
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■ リターゲッティング (230 ページ)

■ リニアキー (230 ページ)

■ リファレンスノード (230 ページ)

■ リモートポート (230 ページ)

■ ループ (230 ページ)

■ レイヤ (230 ページ)

■ レストポーズ (231 ページ)

■ レンダリング (231 ページ)

■ ローカル座標 (231 ページ)

■ ローカルブレンド (231 ページ)

■ ロール (231 ページ)

わ行
■ ワールド座標 (231 ページ)

■ ワールド座標系(WCS) (232 ページ)

■ ワイヤフレーム (232 ページ)

用語の定義
ここでは、MotionBuilder 特有の用語のほか、3D 業界でよく使用される CG お
よびソフトウェア関連の用語について説明します。

英数字

.fbx

標準な 3D データ圧縮ファイル形式。FBX ファイルは、どのソフトウェアで作
成したかまたはどのように変換されたかに関係なく、すべての主要な 3D ソフト
ウェアパッケージで解凍、読み込み、および使用が可能です。
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3D 座標空間
ユークリッド座標環境およびデカルト座標環境。X 軸、Y 軸、Z 軸とそれぞれ対
応する座標値によって三次元を定義します。

X 軸 (196 ページ)、Y 軸 (197 ページ)、Z 軸 (197 ページ)も参照してください。

3D マット
キーおよび輪郭の領域を満たすカラー信号。通常のマットと違い、3D マットに
は奥行きがありシーン内のその他の三次元オブジェクトによって配慮されている
ので、シーンのパーツを遮へいしてビデオ映像と置き替えることができます。

Actor Face

MotionBuilder で、パフォーマの顔をキャプチャした光学または磁気のモーショ
ンデータセット。Character Face アセットにマップされます。

Back Plate

シーンの背景プレーンに表示される、背景画像、ビデオクリップ、またはビデ
オ入力。

ソフトウェアによっては 1 つの単語として表現される場合もあります。

BaseAnimation レイヤ
デフォルトのアニメーションレイヤ。アニメーションをプロットすると、この
レイヤにその他すべてのレイヤのアニメーションがマージされます。

レイヤ (230 ページ)も参照してください。

BCC

背景色消去（BCC） (219 ページ)を参照してください。
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BCS

背景色抑制（BCS） (219 ページ)を参照してください。

biped (二足歩行)
MotionBuilder で、二本の脚で立つ人間型スケルトン。床に接触するのは二本
の脚だけです。

BVH (Biovision Hierarchical Data)
スケルトンの階層情報とモーションデータからなるキャラクタアニメーション
ファイル形式。

最も一般的なモーションキャプチャデータファイル形式の 1 つで、主に人体の
モーションキャプチャに使用されます。

BVH

BVH (Biovision Hierarchical Data) (187 ページ)を参照してください。

COM ポート
通信ポートとも呼ばれる、通信インタフェースのコネクタ。

Distribution Factor

スライダ。シャドウ色とハイライト色をどのような階調で割り当てるかを調整し
ます。

Done 状態
光学装置のマーカでの 1 つの状態。Done と設定すると、そのマーカはアクティ
ブな光学式マーカではなくなり、Optical 設定で使用できなくなります。Done
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となった光学式マーカは、FCurves ウィンドウでフィルタ処理して修正すること
ができます。

Dopesheet

従来からのセルアニメーションのタイミングシートに似た視覚表示。キーの移
動方法、タイミングの修正、時間の経過に伴う効果のオン／オフを示します。

MotionBuilder では、Dopesheet ウィンドウは、Transport Control ウィンドウ
内で、Action タイムラインを展開表示したものです。

Expression コンストレイン
Expressions とも呼ばれます。Expresssions ペインで入力されたデータを使用し
て作成されます。

コンストレイン (209 ページ)も参照してください。

FCurve

ファンクションカーブ (222 ページ)を参照してください。

fill

映像の合成で、キー信号によって切り取られた背景映像の "穴" を埋めるビデオ
信号。

First Contact バルーン
SteeringWheel の起動中にカーソルを固定すると表示される、インタラクティブ
なグラフィカルツールチップ。
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FK (フォワードキネマティクス)
下位の階層のエレメントが親エレメントの動きに従うような、階層の移動方法
(リムなど)。たとえば、フォワードキネマティクスを使用して肩を回した場合、
上腕、前腕、手、指が従います。

IK (インバースキネマティクス) (190 ページ)も参照してください。

FK

FK (フォワードキネマティクス) (189 ページ)を参照してください。

FK エフェクタ
エフェクタ (200 ページ)を参照してください。

FK (フォワードキネマティクス) (189 ページ)も参照してください。

FK リグ
モデルのスケルトン上にある個々のピボットポイントを制御する順運動学シス
テム。

fps

フレーム/秒。

フレームレート (223 ページ)を参照してください。

Global キーインググループ
Global キーイングモードとも呼ばれます。カスタムキーインググループで、
アニメーションシーン内のすべてのキャラクタまたはオブジェクトに適用する
ことができます。Global キーインググループでは、アニメーションシーン内で
キーフレームを作成したときにキャプチャされる、キャラクタまたはオブジェク
トのプロパティ(たとえば、スケールや移動のプロパティ)のセットを定義しま
す。Global キーインググループはシーン内のすべてのオブジェクトまたはキャ
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ラクタに割り当てることができます。ただし、割り当てられるキーインググルー
プのプロパティは、オブジェクトまたはキャラクタに設定済みのプロパティに直
接マッピングされるプロパティだけです。

Hardware FC

ハードウェアの完全制御。特殊なデータ転送プロトコルで、特定のハードウェア
装置間のデータの流れを制御します。

HSB

Hue (色相)、Saturation (彩度)、Brightness (明度)を表す 3 つの数値。

HUD

視線をそらなくても視覚的に確認できる情報のこと。

HUD (ヘッドアップディスプレイ)という名前は、最新の航空機で使われている
ヘッドアップディスプレイからきています。もともとは、頭を「下げて」機器
を確認しなくても、頭を「上げて」前方を見ながら情報を確認できるという意味
です。

IK (インバースキネマティクス)
接続されたジョイントのグループ(リムなど)を座標変換する方法。ここでは、末
端にあるジョイントの動きは、IK チェーンの先行ジョイントすべてに影響を与
えます。

たとえば、腕の手首ジョイントを変形させると、肘と肩のジョイントもまた変形
させられます。

FK (フォワードキネマティクス) (189 ページ)も参照してください。

IK

IK (インバースキネマティクス) (190 ページ)を参照してください。
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IK エフェクタ
エフェクタ (200 ページ)を参照してください。

IK (インバースキネマティクス) (190 ページ)も参照してください。

IK リグ
IK エフェクタを使用して、ボーンの階層を変形するインバースキネマティクス
システム。

IK (インバースキネマティクス) (190 ページ)を参照してください。

IP アドレス
インターネットプロトコル(IP)によって定義される、32-bit のホストアドレス。

Local キーインググループ
カスタムキーインググループで、アニメーションシーンの 3D 空間内でオブ
ジェクトにキーフレームを作成したときにキャプチャされる、そのオブジェクト
のプロパティのセットを定義します。Local キーインググループは、作成時に選
択されていたオブジェクトにのみ割り当てることができます。

Mipmap

1×1 ピクセルの大きさに縮小されたオリジナルテクスチャ。これが Viewer が遠
ざかったときの、小さなオブジェクトの "ちらつき" 問題を解消します。

テクスチャ (216 ページ)も参照してください。

NTSC (National Television System Committee)
全国テレビジョン方式委員会(NTSC)の規格。同委員会が策定した、米国および
その他の国におけるカラーテレビの規格です。
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NTSC は、フレームサイズ、フレームレート(29.97fps)、フレームアスペクト
比、ピクセルアスペクト比で定義されています。NTSC の標準方式はいくつも
の部門に分かれており、それぞれの部門でフレームサイズ、ピクセルアスペク
ト比、フレームアスペクト比が決まっていますが、NTSC 標準方式の標準フレー
ムアスペクト比は 4:3 (1.333)です。また、この方式の解像度は 640 x 480 で
す。

Null (ヌル)
他のオブジェクトに対してペアレント化できるオブジェクトで、変形を柔軟にす
ることができます。ヌルは特定のプロパティを持たず、シーンの構築に使用する
と便利というだけです。Viewer ウィンドウでは、ヌルは小さな軸として表示さ
れます。

NURBS (Non Uniform Rational B-splines)
不均一な理論的 B-スプライン関数。モデリングに際して使用する、視覚的に複
雑な幾何学情報を表示する表面および曲線。

NURBS (Non Uniform Rational B-splines)
NURBS (Non Uniform Rational B-splines) (192 ページ)を参照してください。

Object キーインググループ
カスタムキーインググループで、オブジェクトにのみ使用できます(キャラクタ
には使用できません)。キーフレームを作成したときに、アニメーションシーン
の 3D 空間内でキャプチャされるオブジェクトのプロパティのセットを定義しま
す。Object キーインググループは、シーン内のすべてのオブジェクトに割り当
てることができます(Local キーインググループは、作成時に選択されていたオ
ブジェクトにしか使用できません)。
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OpenGL

レンダリングや画像の操作をサポートするグラフィック用ハードウェアに対する
ソフトウェアのインタフェース。

Optical エディタ
光学データの補正、質の悪いギャップ補間の修正、スワップしたマーカの切替、
およびその他の光学的データの再構築を行うエディタ。

ノイズ(218ページ)、オクルージョン(201ページ)、部分的なオクルージョン(222
ページ)も参照してください。

PAL

Phase Alternating Line の規格。多数のヨーロッパ、アフリカ、アジア諸国で使
用されているカラーテレビの規格です。

PAL は、フレームサイズ、フレームレート(25fps)、フレームアスペクト比、
ピクセルアスペクト比で定義されています。PAL の標準方式はいくつもの部門
に分かれており、それぞれの部門でフレームサイズ、ピクセルアスペクト比、
フレームアスペクト比が決まっていますが、標準の PAL ビデオ信号方式では、
ビデオの再生レートは 25fps、各フレームの走査線数は 625 本に設定されていま
す。

Phase Alternating Line (PAL)
PAL (193 ページ)を参照してください。

Qt

クロスプラットフォームアプリケーションの開発フレームワーク。GUI プログ
ラムの開発に広く利用されているほか(この場合は、ウィジェットツールキット
と呼ばれます)、コンソールツールやサーバといった非 GUI プログラムの開発
にも使われています。

Qt は C++ をベースとしており、コンパイル前に標準の C++ コードを生成する
プリプロセッサを追加することで、標準以外のいくつかの拡張機能を実装できま
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す。Qt はあらゆる主要プラットフォームに対応しているほか、世界中でサポー
トされています。非 GUI 機能としては、SQL データベースアクセス、XML 構
文解析、スレッド管理、ネットワークサポート、ファイル処理用の統合クロス
プラットフォーム API などが挙げられます。

Qt が使われているアプリケーションの代表例が、KDE、Opera、Google Earth、
Skype、Qtopia、Photoshop Elements、VirtualBox、OPIE などです。また、
Qt はさまざまなプログラミング言語でも使用されており、Ada (QtAda)、[3] C#
(Qyoto/Kimono)、[4] Java (Qt Jambi)、[5] Pascal、Perl、PHP (PHP-Qt)、Ruby
(RubyQt)、Python (PyQt)などのバインディングがあります。

quadruped (四足歩行)
床との接触を 4 本の足すべてで行う 4 本足のスケルトン。

Relation

Relation コンストレイン (194 ページ)を参照してください。

Relation コンストレイン
Relations とも呼ばれます。コンストレインされたオブジェクトの動作を決定す
る、ソースオブジェクトのデータに基づいて指定したオペレーションを実行し
ます。

コンストレイン (209 ページ)も参照してください。

SMPTE

米国映画テレビ技術者協会(Society of Motion Picture and Television Engineers)。
モーションイメージング分野の見解や発展を促進することを目的に 1916 年に
設立された機関。

SteeringWheels

2D/3D ナビゲーションツールにアクセスするためのツールセット。
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TCB (Tension、Continuity、Bias)
テンション、連続性、バイアス。

Timecode

カレントテイク中のカレント位置を示す値。

T-スタンス
T ポーズと似た、キャラクタのニュートラルポーズ。腕がボディから 90 度の角
度で、脚が完全に伸び、足は床に並行に接地し、背骨はまっすぐの状態です。

UCS

ユーザ座標系(UCS) (229 ページ)を参照してください。

ワールド座標系(WCS) (232 ページ)も参照してください。

Up ベクトル
極ベクトル (206 ページ)を参照してください。

UV

U および V のテクスチャ座標。U および V は、3D メッシュ上に配置された 1×1
ピクセル画像のベクトルを意味します。U 座標および V 座標を使用すると、テ
クスチャを 3D メッシュ上に正確に配置できます。この配置では、テクスチャを
オブジェクトのサーフェスに関連付け、継ぎ目のない効果を作成するためにマッ
プされます。
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ViewCube

モデルのカレントの向きを表示するユーザインタフェース要素。ViewCube を
使用して、UCS の復元や作成、ビューの復元、ビューをインタラクティブに回
転させるといった操作を行うことができます。

VK Ripple

視覚的キーフレームリップル。

視覚的キーフレーム (211 ページ)も参照してください。

VTR (Video Tape Recorder)
ビデオテープレコーダ。

WCS

ワールド座標系(WCS) (232 ページ)を参照してください。

ユーザ座標系(UCS) (229 ページ)も参照してください。

X 座標
原点に対してシーン内の水平方向の空間を定義している値。

X 軸
シーンの水平方向の空間を定義する次元。

3D 座標空間 (186 ページ)も参照してください。

Y 座標
原点に対してシーン内の垂直方向の空間を定義している値。
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Y 軸
シーンの垂直方向の空間を定義する次元。

3D 座標空間 (186 ページ)も参照してください。

Z 座標
原点に対してシーン内の奥行きを定義している値。

Z 軸
シーンの奥行きを定義する次元。

3D 座標空間 (186 ページ)も参照してください。

あ行

アーティファクト
モーションキャプチャデータの望ましくないエレメントまたは欠陥。自然に発
生するものであり、取り除いてより質の高いキャプチャを作成することができま
す。

アクター
MotionBuilder で、キャプチャされた光学式または磁気式のモーションデータ
をキャラクタにリンクするために使用される人間型モデル。

アセット
MotionBuilder で、モデル、テクスチャ、シェーダなどのアニメーションを作
成するためのエレメント。
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値
モデルの位置、回転、またはスケーリングからマテリアルの放射、周囲光、また
は拡散反射光の色の値まですべてを定義する数字。

プロパティ (223 ページ)も参照してください。

アニメーション
連続する画像を素早く続けて表示することで、動画と錯覚させる方法。それぞれ
の連続する画像では、複数の値が時間と共に変更され、画像内に描画または記録
されたアイテムが動いているように見えます。

アルファチャンネル
透明度情報を保管する各ピクセルのデータの一部。32 ビットのグラフィックシ
ステムには、4 つのチャンネルがあります。赤、緑、青(RGB)用の 8 ビットチャ
ンネルが 3 つとアルファチャンネル用の 8 ビットチャンネルが 1 つです。

アルファブレンド
立体、不可視、または部分的な透明のピクセル値を割り当てるときの効果。アル
ファブレンディングは、爆発や武器の発射などの特殊な効果としてゲームでしば
しば使用されます。ポリゴン上にマップすると、アルファブレンディングは水や
ガラスなどの半透明のオブジェクトをシミュレートします。

アンチエイリアシング
画面上の斜線のエッジを滑らかにしてエイリアシングを補正する方法。アンチエ
イリアシングを使用しないと、ピクセルの階段効果によって斜線が "ギザギザ"
に見えることがあります。アンチエイリアシングは線のエッジをぼかします。

エイリアシング (200 ページ)も参照してください。
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安定化オブジェクト
すべてのブレンディングオブジェクトを安定化し足がスライドする問題を補正
する、センサ、スケルトンのノード、またはモデル階層のモデル。

オブジェクトのブレンド(blending object) (201 ページ)も参照してください。

移動(translation)
1 つの軸またはすべての軸上でオブジェクトを移動する方法。移動は、その向き
を変更せずにオブジェクトを移動します。

色信号の交雑
色の交雑とも呼ばれ、ビデオエンコーダで色情報として輝度の詳細が誤って解
釈された場合に、エンコードされたビデオ画像に作成されるモアレや虹色の効果
です。たとえば、モアレは細い縦縞の衣類などに影響を与えます。

色タイミング
2 つ以上のビデオ信号のカラーバーストフェーズの同期化。これによって、信
号がスイッチャまたは他のビデオデバイス内で混合されるときに、カラーの推
移が画像内に発生しないようにできます。

色の交雑
色信号の交雑 (199 ページ)を参照してください。

ウェイト付けされた接線
ファンクションカーブ上のウェイトが付けられた接線で、接線ハンドルを伸ば
してウェイト付けのない接線では作成できない特別な曲線を作成できます。

ファンクションカーブ (222 ページ)およびウェイト付けのない接線 (200 ページ)
も参照してください。
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ウェイト付けのない接線
ファンクションカーブ上の接線で、ウェイト付けがされていないもの。

ファンクションカーブ (222 ページ)およびウェイト付けされた接線 (199 ページ)
も参照してください。

エイリアシング
たとえば輝度や色信号の周波数など、二つの周波数間の干渉によって発生したテ
レビ画像の異常または歪み。エイリアシングはモアレパターンまたはヘリンボ
ンパターン、本来は直線なのに波うつ、または虹色がかった現象が発生します。

アンチエイリアシング (198 ページ)も参照してください。

エクスプレッション
プロパティとエレメントのアニメートに使用する数式。

エフェクタ
キャラクタのジョイントを表すコントロールリグ上のマーカ。エフェクタは、
Character 設定のキャラクタ上にセルで視覚的に表示され、選択してキャラクタ
の対応するボディ部分を変形することができます。エフェクタには 2 つのタイ
プがあります。FK エフェクタと IK エフェクタです。

FK (189 ページ) および IK (190 ページ) を参照してください。

補助エフェクタ (226 ページ)も参照してください。

エレメント
ノードシーンを作り上げるすべてのオブジェクトです。
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オクルージョン
光学式モーションキャプチャで発生する問題。3 台以外のカメラからセンサが
隠れたときに発生します。これは、パフォーマが障害物を通過するときまたはパ
フォーマの体がセンサとカメラの間に入ったときに生じます。

オブジェクトのブレンド(blending object)
MotionBuilder では、キャプチャしたデータを持つノードまたはセンサ、プロッ
トしたデータを持つモデルの一部またはすべての階層、あるいはコントロール
リグを選択して、モーションブレンドを行います。

か行

階層
エレメント間の関係を視覚的に説明する組織構造。階層は、1 つのエレメント(親
と見なされる)を一番上にしていくつかのエレメント(子として見なされる)を先行
するエレメントの下にしている、反転したツリー構造に似ています。

ペアレント(parent) (223 ページ)および子階層 (208 ページ)も参照してください。

回転(rotation)
3 つの軸それぞれの軸回りを回転する角度を示す、オブジェクト上のすべてのポ
イントを変更する方法。

ガイドポーズ
キャラクタをポーズに従わせたいときに、Ragdoll ソルバで使用できるキャラク
タポーズの 1 つ。ガイドポーズを取ろうとすると不自然にねじれてしまうとき
は、キャラクタはガイドポーズに従いません。Viewer ウィンドウでは、ガイド
ポーズは緑色の棒で表されます。

つまり、ガイドポーズはマッチポーズほど決定的ではありません。マッチポー
ズ (227 ページ)も参照してください。
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カスタムキーインググループ
カスタムキーイングモードとも呼ばれます。キーフレームを作成したときにキャ
プチャされる 3D 空間内のキャラクタのエフェクタ(またはオブジェクト)を定義
する、ユーザ定義のプロパティのセット。

カスタムキーインググループには、Global (シーン内のすべてのキャラクタま
たはオブジェクトに適用できる)、Local (キーインググループの作成時に選択さ
れていたオブジェクトにのみ適用される)、Object (シーン内のすべてのオブジェ
クトに適用できる)の 3 つのタイプがあります。

カット
テイクのアニメーションのセクション。

カメラ
シーンを表示して記録するための装置。それぞれのカメラは、異なるアングルま
たは「視点」からシーンを見ます。

カメラの注視点
観察位置とも呼ばれます。ヌルによって表されるカメラの焦点位置です。

カラーバースト
バーストとも呼ばれます。画像の色(色相)を確立するリファレンスです。

カレントセグメント
Optical エディタで現在選択されている光学データのセグメント。(Label ペイン
で Done と設定するのではなく)セグメントを選択してアクティブにすると、緑
色に変わります。

セグメント (214 ページ)も参照してください。
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環境マッピング(Environment mapping)
単一の視点からモデルを撮影するときに最適な、反射マッピング形式。

観察点
カメラの注視点 (202 ページ)を参照してください。

キー
キーフレームを設定する処理。

キーインググループ
キーイングモードとも呼ばれます。キーフレームの作成時に記録される、キャ
ラクタのエフェクタまたはオブジェクトのプロパティのセットです。

キーフレーム
特定の時間において、シーン内で重要な動作または変更の位置を示す参照点ある
いはキーポイント。

キーフレーム操作
特定の時間におけるシーン内のオブジェクトを変換し、キーフレームを設定する
ことによって、キーフレームアニメーションを作成する操作。

基点
3D シーンの中央に位置する点であり、すべての位置が相対的に定義されます。
シーンの基点における X、Y、Z の座標の値は 0 です。

選択した 3D オブジェクトの基準点の中央。オブジェクトの表面が相対的に定義
されます。オブジェクトの基点では、すべての 3D 座標の値は 0 であり、(0,0,0)
と表記します。
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グローバル座標 (207 ページ)およびローカル座標 (231 ページ)も参照してくださ
い。

輝度
ビデオ信号の光の強度。色画像情報には 2 つのコンポーネントが含まれていま
す。輝度(明度とコントラスト)および色信号(色相と彩度)です。定義の範囲内に
ある輝度へのリファレンスは、ほとんど削除されます。

クロミナンス (207 ページ)も参照してください。

輝度キー
背景映像で、クリップレベルよりも輝度の高いキーソースの部分で穴またはキー
を切り取るキー効果。

ギャップ
センサーのデータを含まない、マーカのセグメントの前後またはその間の空間。

キャラクタ
キャラクタアセット (204 ページ)を参照してください。

キャラクタアセット
MotionBuilder では、キャラクタとも呼ばれます。モーションソース (228 ペー
ジ)(アクター(197ページ)、コントロールリグ(209ページ)、その他のキャラクタ)
とキャラクタモデル (205 ページ)の間のリンクです。

モデル (228 ページ)も参照してください。

キャラクタアニメーション
オブジェクトまたはモデルに対して、個性、命、特徴を与えるためにアニメー
ションを付ける処理。他のタイプのアニメーションとは異なり、オブジェクトを
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生き生きと見せ、ランダムに動いているのではなく自ら能動的に動いているよう
に見せることを目的としています。

キャラクタフェイス
MotionBuilder のフェイスモデルの形状。形状データの入力、記録されたモー
ションキャプチャデータ、デバイス、およびコンストレインによって動かされ
ます。

シェイプ (210 ページ)も参照してください。

キャラクタマッピング
データソースとスケルトンがバインドされている 3D モデルの間にリンクを作
成する方法。

キャラクタアセット (204 ページ)も参照してください。

キャラクタモデル
MotionBuilder の 3D オブジェクトは、スケルトンがバインドされているスキン
モデルで構成されています。

キャラクタモデルは、キャラクタアセットを介してモーションソースにリンク
することでアニメートできます。

モデル (228 ページ)、スケルトン (213 ページ)、モーションソース (228 ページ)、
キャラクタアセット (204 ページ)も参照してください。

球体マップ
3D オブジェクトにシーンのコンテンツを反映する反射形式。

球面マップ
一ヶ所だけからの視点でそのシーンのコンテンツを 3D オブジェクトに反映する
反射形式。
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極ベクトル
開始ジョイントを起点とする IK 回転プレーンハンドルの一部で、ハンドルベ
クトルとともに IK ハンドルのリファレンスプレーンを定義します。

極ベクトルではリファレンスプレーンの方向をコントロールできるため、ジョ
イントチェーンの方向を直接変更できます。これは、ジョイントチェーンの方
向(つまり、ツイスト)の角度が、リファレンスプレーンとジョイントチェーン
プレーンの方向の差として定義されるためです。

なお、他のソフトウェアパッケージでは、極ベクトルは「アップベクトル」な
どとも呼ばれます。

クォータニオン
4 つの幾何学コンポーネントで構成された複雑な数。

クォータニオンでは、3 つのコンポーネントベクトルを定義する[x, y, z]値に 4
番目の要素が加わります。クォータニオンは、3D 空間における軸とその軸を中
心とした回転を表現します。

クラスター
オブジェクトにリンクできる頂点の集合。

クラスターシェイプ
クラスターグループから形成される形状。Shapes Mapping ペインで使用する
ために、クラスターを移動、回転、スケールしたもの。

キャラクタフェイス (205 ページ)およびクラスター (206 ページ)も参照してくだ
さい。

クリップ
ストーリ設定におけるアニメーション、音声、コマンド、コンストレイン、ビデ
オ、カメラショット、個々のオブジェクト。
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定義された境界で切り取られたデータの一部。

グローバル座標
(X、Y、Z)の形式で、シーンの基点に対する位置を定義する値。

ローカル座標(231ページ)、X 座標(196ページ)、Y 座標(196ページ)、Z 座標(197
ページ)も参照してください。

クロマキー
色の付いた背景をサンプリングする効果のことで、背景を、映像レイヤなど何か
別のもので置き換えます。

クロミナンス
ビデオ信号のうち、色情報(色相や彩度)を含む部分。ビデオ画像情報には 2 つの
コンポーネントが含まれています。輝度と色信号です。

輝度 (204 ページ)も参照してください。

黒レベル
伝達可能な最低の輝度レベルのことで、ビデオ信号のアクティブな画像部分中に
発生する可能性があります。モニタに表示すると、この信号レベルは黒く見えま
す。

光学式マッピング
光学式モーションデータをアクターにマッピングする処理。

光学式ルート
Viewer ウィンドウ内に球面で表示される、インポートした光学データに対する
主要なリファレンス。
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効果の送信
ビデオスイッチャの機能。デジタル画像のマニピュレータに送信されるキーソー
スを選択できます。操作対象のキーおよびフィルビデオはスイッチャのキーヤ
に戻され、背景映像上でキーイングを行います(キーを「飛ばします」)。

ゴースト
Viewer ウィンドウ内のレンダリングしていないオブジェクトのブレンドのワイ
ヤフレーム表示。ゴーストは、Motion Blend ウィンドウまたは Story ウィンド
ウが開いているときにだけ表示されます。

オブジェクトのブレンド(blending object) (201 ページ)も参照してください。

ゴースト曲線
曲線を編集するときに FCurves ウィンドウ内に表示される、オリジナルの曲線
表示。

子階層
階層構造において、他の下に位置づけられるモデルまたはエレメント。たとえ
ば、Marker2 は Marker1 によってペアレント化されています。階層構造では、
Marker2 は子であり Marker1 が親です。

階層 (201 ページ)およびペアレント(parent) (223 ページ)も参照してください。

ゴボ
照明上に取り付けられるフィルターで、パターンを投影します。

コマンドクリップ
トラック内の特定のフレームにおけるモデルを表示／非表示にできるクリップ。
またコマンドクリップを使用して、外部アプリケーションを起動することもで
きます。
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コンストレイン
他のオブジェクト(ソースオブジェクト)の動作に基づいて、動作を制約されるオ
ブジェクト(制約付オブジェクト)。

コンストレインされたオブジェクト (209 ページ)およびソースオブジェクト (215
ページ)も参照してください。

コンストレインクリップ
Story ウィンドウのトラック全体で、コンストレインを選択、ブレンド、および
解除することができるクリップ。正しい結果を得るためには、コンストレインが
作用するように、アニメーションの下に Constraint トラックを配置する必要が
あります。

コンストレインされたオブジェクト
その動きを他のオブジェクトの動作によって決定されるオブジェクト。コントラ
ストを使用します。

コンストレイン (209 ページ)も参照してください。

コントラスト
明度と同様に、オブジェクトの輝度を決定するプロパティ。

コントロールリグ
IK リグと FK リグを組み合わせたものを使用して、キャラクタアニメーション
を作成し変更できるデータソース。

コンバイナ
2 つ以上のチャンネルが一緒にどのようにして機能するかを制御するデバイス。
これによってチャンネルの優先順位(どの画像を手前側または後ろ側に表示する
か)、およびそれらの画像間で行うことができる移行のタイプを指定します。
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チャンネル (216 ページ)も参照してください。

さ行

彩度
オブジェクトの色のクロミナンスおよびコントラストの決定に関わるプロパティ。

座標変換
移動、回転、スケーリングによってオブジェクト上のポイントを変更する方法。

サンプル
各フレームにおいてそれぞれのカメラで録画されるセンサの位置。各カメラのす
べてのサンプルは、処理が行われるときにタイミングを合わせて、各センサ位置
の 3D 表示を生成します。

キーフレーム (203 ページ)も参照してください。

シーン
座標系を使用して、その中でオブジェクトを配置してアニメートする三次元空間
の表示。

3D 座標空間 (186 ページ)も参照してください。

シェイプ
Character Face 設定内で、Character Face を修正して、「怒り」などの特定の
感情を表現します。

キャラクタフェイス (205 ページ)も参照してください。

210 | 用語集



シェイプ操作
モーフターゲットとも呼ばれます。シェイプアニメーションのあるモデルで使
用される特別な操作。

シェーダ
3D モデリングにおいて、「シェーダ」という用語は、サーフェスがライトにど
のように反応するかを指定するアルゴリズムを意味しています。MotionBuilder
での「シェーダ」は、異なるタイプのエフェクトを作成するためにモデルに適用
するアセットです。さまざまなタイプのシェーダで、サーフェスがライトにどの
ように反応するかを定義したり、カートゥーン調の輪郭やバンプマッピングな
どの特殊なエフェクトを作成したりできます。また、シェーダを使って、静的な
光源を含むシーンにシャドウマップやライトマップを生成することもできます。
MotionBuilder では、Open Reality® SDK を使用して作成したカスタムシェー
ダもサポートしています。

視覚的キーフレーム
矢印の形をしたタブで、Action タイムラインおよび Dopesheet ウィンドウのタ
イムラインの上にあり、設定されたキーフレームの位置を示します。

キーフレーム (203 ページ)も参照してください。

色相
特定の色。たとえば、Color ウィンドウ内の Hue スライダを使用して、オブジェ
クトの色相をグリーンに設定できます。

磁気マッピング
磁気モーションデータをアクターにマッピングする処理。
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シャドウマップ
シャドウマップシェーダによって作成される .tiff イメージ。シーン内の面およ
びオブジェクトに投影されます。

シャトル
オーディオの再生中に、オーディオトラックを早送りまたは高速逆再生するこ
とです。

ジョイント
ボーンによって接続されている、スケルトン上のポイント。

ジョグ操作
Viewer ウィンドウ内で、J キーを押しながらドラッグしたときの、テイク内で
時間をスムーズに前後に移動する動作。

シリアルポート
COM ポートとも呼ばれます。特殊な通信プロトコルを使用してデバイス間のフ
ローを制御するポートのことで、より高速に転送を行うことができます。

シンプルコンストレイン(Simple Constraint)
事前に定義した制約付オブジェクトおよびソースオブジェクトのリストを使用
するコンストレイン。

スキン
3D キャラクタを包み込む頂点のメッシュで、キャラクタの形状を形成。

212 | 用語集



スクラビング
オーディオの再生中に、オーディオトラックを前後に移動するプロセス。この
プロセスを使用して、特定のフレームにあるオーディオを探したり聞いたりしま
す。

スケーリング
オブジェクトの中心から外側に向かってすべてのポイントを移動してオブジェク
トを拡大、または中心に向かってすべてのポイントを内側に引っ込めてオブジェ
クトを縮小する方法。

スケルトン
ジョイントを示すポイントとボーンを示す接続ラインのセット。

スタック
後入れ先出しの順番でアクセスする項目を保管するデータ構造。

スタンスポーズ
モデルの開始ポーズまたはレストポーズ。

スプライン
基準点を使用して定義された曲線。

スワッピング
光学式モーションキャプチャに関わる問題。2 つのマーカが互いに交差または
近くを通過したところで、キャプチャ装置がマーカを間違って解釈してセグメン
トに対して間違ったラベル付けをします。

モーションキャプチャ (228 ページ)も参照してください。
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セグメント
光学式モーションキャプチャセッションでキャプチャしたデータ。

カレントセグメント (202 ページ)およびモーションキャプチャ (228 ページ)も参
照してください。

接線ハンドル
ファンクションカーブ上のキーフレームの接線を視覚的に表示したもの。接線
ハンドルを使用すると、キーフレームのどちら側の曲線の傾斜も変更できます。

ゼロキーフレーム
指定の時間にレイヤの効果を 0 に設定したキーフレーム。

アニメーションの開始または終了を定義するキーフレームのセット。

レイヤ (230 ページ)も参照してください。

ゼロポイント
移動と回転の両方が 0 に設定されたアクターのスタンス。

全国テレビジョン方式委員会(NTSC)
NTSC (National Television System Committee) (191 ページ)を参照してくださ
い。

センサ
パフォーマの体に取り付けた反射板または光源。センサは、キャプチャ操作中に
光学式カメラによって記録されます。キャプチャしたデータは、セグメント化す
るために組み合わされます。

モーションキャプチャ (228 ページ)およびセグメント (214 ページ)も参照してく
ださい。
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ソースオブジェクト
コンストレインの基準となるオブジェクト。

コンストレイン (209 ページ)も参照してください。

属性
プロパティ (223 ページ)を参照してください。

ソルバ
FK および IK のリグ両方の位置を計算し、Character Settings ペインでの設定を
保ったままで、その結果をリンクしたモデルに適用する方法。

それぞれのリグを計算した結果。たとえば IK ソルバは、IK リグを計算した結果
のことです。

MotionBuilder では、キャラクタエンジンを使用する場合の計算の結果、リグ、
および設定すべての結果です。

た行

タイムワープ
ファンクションカーブの形状を変形し、アニメーションのタイミングを変更す
るカーブ。

ファンクションカーブ (222 ページ)も参照してください。

ダミーノード
親ノードに使用する幾何学データを含まないノード。

ノード (218 ページ)も参照してください。
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チャンネル
映像用のデジタル効果のプロセスパス。

特定の信号パス。

MotionBuilder は、チャンネルを使用して、Actor Face アセットを Character
Face アセットとコネクトし、3D モデルの表情を作成します。

通信ポート
COM ポート (187 ページ)を参照してください。

テイク
ある時点のアニメーションインスタンスのスナップショット。

注: 時間の単位は時間、分、秒、フレーム/秒(fps)を使用できます。

テクスチャ
さまざまなテクスチャアセットによって、イメージまたはビデオファイルを、
マテリアル、レイヤ構造のテクスチャ、モデルに適用できます。テクスチャの最
も一般的な用途は、モデルのジオメトリを追加せずにモデルのサーフェスにディ
テールを加えることです。テクスチャは、マテリアルおよびシェーダとともに使
用します。

デッキ
ビデオカセットレコーダー(VCR)。

テッセレーション
レンダリングプロセスの 1 つの段階で、オブジェクト表面のメッシュの形状を
三角形に配置しなおします。
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デバイス
特定の機能を持ったハードウェア機器。MotionBuilder では、マウスや MIDI
デバイスなどの入力デバイスを使用できます。

デフォーメーション
基準点の幾何学メッシュに基づいてオブジェクト表面をモデリングする方法。

透明度
オブジェクトの可視性のレベルで、不透明度の設定によって決定されます。不透
明度を 0%に設定すると、オブジェクトは透明になります。

トラック
何かが移動する経路、または時間の経過に伴う一連のイベント。

MotionBuilder には、2 種類のトラックがあります。Motion Blend ウィンドウ
では、トラックはモーションデータを含んで、テイクを 1 つの結果トラックに
ブレンドできます。Story ウィンドウでは、トラックはモーションデータ、キー
フレームアニメーション、音声と映像を含んで、タイムラインに沿って特定の
種類のクリップをブレンドすることができます。

トリガ
Animation Trigger ウィンドウでは、ジョイスティックまたはキーボードなどの
デバイスでモーションクリップを実行し、作成したトランジションをテストす
ることができます。

トリガグループ
その実行を開始するための、モーションクリップおよびトリガの集合。
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な行

ネームスペース
ネームスペースは一意のパスです。ネームスペース内の各オブジェクトは、それ
ぞれのオブジェクト名とそのオブジェクトが属するネームスペースによって識別
されます。

たとえば、「Moon:Alien」は 1 つのパスです。また、「Galaxy:Moon:Alien」
はこれとは別のパスです。「Galaxy:Moon:Alien」は「Galaxy」の中の
「Moon:Alien」を参照するのではなく、また別の「Moon」を参照します。
「Moon:Alien」と「Galaxy:Moon:Alien」は 2 つの個別のエレメントで、共存
することができるため、名前を変更する必要はありません。

ノイズ
キャプチャセッション中に、パフォーマの体に付けたセンサが部分的にオクルー
ジョンされたために生じた、光学データのセグメント内の不規則なジャンプ。

アルミ製暖房ダクトなどの金属製オブジェクトが、キャプチャセッション領域
に干渉することで発生する磁気キャプチャデータ内の目立つ歪み。

ノード
モデルのスケルトン構造にリンクされた個別のオブジェクト（ジョイント、ボー
ン、ヌルなど）。ノードを使用して、ソースをモデルとマップできます。

Schematic ビューでは、階層の各アセットを表す様々な色が付けられたタイルで
す。

リファレンスノード (230 ページ)およびダミーノード (215 ページ)も参照してく
ださい。

218 | 用語集



は行

バースト
カラーバースト (202 ページ)を参照してください。

背景色消去（BCC）
クロマキー機能の 1 つ。クロマキーの背景色を感知して補色と置き換えます。
その結果、2 つの色が相互に消去されます。これによって、クロマキーの前景
オブジェクトを囲むハロやフリンジング効果が軽減されます。

背景色抑制（BCS）
クロマキー機能の 1 つ。クロマキーの背景色を感知して、調整可能な輝度レベ
ルに置き換えます。これで背景色がクロマキーに表示されなくなります。

背景面
シーン内の 1 つの面。その上に画像、ビデオクリップ、またはビデオ入力が投
影されます。

バインドポーズ
MotionBuilder では、キャラクタのウェイト付けに使用される位置のことで、
キャラクタのすべての手足がニュートラルポジションにあり、完全に伸ばされ
たり縮められたりはしていません。

バウンディングボックス
Actor Face で、フェイスモデルの目、眉、口を動かすことのできる範囲を制限
するリジッドボディ。
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バウンドモデル
MotionBuilder で、リジッドスケルトンをバインドし、メッシュで覆われた 3D
モデル。メッシュには、モデルに識別可能な外見をもたらすテクスチャとボディ
機能があります。

波形
サウンドの振幅の時間軸上の連続的な変化を図形に表したものです。

バックグラウンドジェネレータ
色相、色度、および輝度を調整できる無地の出力を生成する映像ジェネレータで
す。

パッチ
テッセレーションのタイプの 1 つで、モデルの表面に施されます。

バッチ処理
頻繁に実行されるタスクを、コマンドをスクリプトまたは "バッチファイル" に
保管して、自動化する処理方法。

たとえばバッチ読み出しとは、1 つのコマンドで複数のファイルを読み出して処
理することを意味します。

バッファ
メッセージを保管するためのメモリ領域。

パラメータ
プロパティ (223 ページ)を参照してください。
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反応時間
コントローラがデータトラックの検索を開始した後、データが回転して所定の
位置に来るまでの読み込み／書き込みヘッドの待機時間です。

バンプマップ
2 つの方向ベクトルを含み、テクスチャ内の浮き彫りを伝えるために使用される
テクスチャ。

テクスチャ (216 ページ)も参照してください。

ピッチ
Y 軸に沿った上下の運動に基づく回転。たとえば、上下に傾く飛行機など。

ビットプレーン
完全なピクセル当たり 1 ビットの画像を保持する、画像表示装置内のメモリ。

ピボット(基点)
選択したオブジェクトの変換を行う始点。

補助ピボット (226 ページ)も参照してください。

標準チャンネル(generic channel)
事前に設定された表情のチャンネル。

Actor Face (186 ページ) およびチャンネル (216 ページ)も参照してください。
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ファンクションカーブ
FCurve とも呼ばれます。アニメートされた値の図形描写。アニメートされた値
の時間と値が、2 つの軸上に表示されます。縦軸は値を表し、横軸は時間を表し
ます。

フィルタ
キャプチャしたモーションデータから不要なデータの取り除き、操作、または
修正を行うツール。フィルタとフィルタオプションを使用して、独自の指定に
従ってキャプチャしたデータを操作したりノイズの多いまたは歪んだモーション
キャプチャデータを補正できます。

フィルタ処理
キャプチャしたモーションデータから不要なデータの取り除き、操作、修正、
または他の方法で調整する方法。

フィルタ (222 ページ)も参照してください。

副搬送波
SC とも呼ばれ、NTSC や PAL ビデオで、ビデオ信号の一部を構成する非常に正
確な周波数の連続的な正弦波です。副搬送波は、画像の色相と色の彩度の情報を
伝えます。

不透明度
オブジェクトの透明さの程度。オブジェクトの不透明度を 100%に設定すると、
そのオブジェクトは不透明に表示されます。不透明度を 0%に設定すると、オブ
ジェクトは透明に表示されます。

部分的なオクルージョン
キャプチャセッション中にパフォーマの体に付けたセンサが互いに近づきすぎ
たとき、またはセンサが部分的にカメラの 1 つから隠れたときに頻繁に発生す
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る、光学モーションデータの問題。結果として得られるデータはにはピーク、
シフト、またはノイズが表示される場合があります。

ブランチ
ノードの組み合わせ間に 1 つだけ経路がある場合の階層またはツリー型のデー
タ構造の一部。ブランチ上のノードは親を 1 つだけ持つことができます。

フレーム
アニメーション内の特定のポイントにおける 1 つの画像。

一連のフィルムまたは 2 つのフィールドで構成される完全なテレビ画像の個々
の画像イメージ。

また、フレームは尺度としても使用されます。

フレームレート
一連のイメージをキャプチャまたは表示する速度。通常は、1 秒あたりのフレー
ム数(fps)で表されます。

プロパティ
属性またはパラメータ。オブジェクト固有の特性を数量化した値で、アニメート
できます。たとえば、光に対して霧が光る強さはプロパティです。

ペアレント(parent)
他のモデルまたはエレメントを親とする、モデルまたはエレメント。たとえば階
層上では、Marker1 は親であり Marker2 は子です。

階層 (201 ページ)および子階層 (208 ページ)も参照してください。
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ペアレント化(parenting)
あるモデルまたはエレメントを他のモデルまたはエレメントの親とすること。

ベクトル
直線セグメント。

ヘッドアップディスプレイ(HUD)
HUD (190 ページ)を参照してください。

ホイール
SteeringWheels を構成する個々のユーザインタフェース要素。複数を指す場合
もあります。

SteeringWheels (194 ページ) も参照してください。

ホイール
SteeringWheels を構成する個々のユーザインタフェース要素の 1 つ。

SteeringWheels (194 ページ) も参照してください。

ホイールウェッジ
ホイールサーフェス上で、特定の 2D/3D ナビゲーションツール用に指定され
ている部分。

ホイールサーフェス
ホイールの、ウェッジや各種ボタンの編成に使用されている領域。
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ボイスチャンネル
Character Face 設定で、口の表情をあらかじめ設定したチャンネル。

チャンネル (216 ページ)も参照してください。

法線
あるものの方向を定義する垂直の位置またはベクトル。

法線マップ
3 つの方向ベクトルを含むテクスチャ。方向ベクトルには X、Y、Z があります。
バンプマップの 2 つのベクトルと違い、法線マップの 3 つのベクトルは高さと
照明のディテールを非常な正確さで伝えるので、リアリズムを高めます。

バンプマップ (221 ページ)およびテクスチャ (216 ページ)も参照してください。

ポーズ
ある時点の、選択したキャラクタまたはオブジェクトの姿勢(状態)のスナップ
ショット。

ボーレート
ビット/秒(bps)。通信チャンネルの情報通信能力を測定するときの速度。

ボーン
MotionBuilder で、アクターのスケルトンを構成するジョイント同士を接続す
る線。
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補外
曲線の論理的な継続を既知の値を元に推測する、数学的アルゴリズムを使用した
方法。

補間
アニメーションを再生するときに、フレームの合間にキーフレーム間に動作を自
動的に埋め込んで、スムーズな連続した動作の映像を作り出す方法。

MotionBuilder では、この補間は、FCurves ウィンドウのアニメーションのキー
フレーム間に描かれるファンクションカーブの形状で示されます。

補助エフェクタ
MotionBuilder で、既存の IK エフェクタに対応するコントロールリグの補助的
なエフェクタ。補助エフェクタは、キャラクタの到達度に対する補足的な IK コ
ントロールを提供し、対応する IK エフェクタ上に立方体として表示します。

エフェクタ (200 ページ)も参照してください。

補助ピボット
MotionBuilder で、現在の位置以外のポイントから IK コントロールリグエフェ
クタを移動、回転させることができるサブコントロールです。

ピボット(基点) (221 ページ)も参照してください。

ま行

マーカ
セグメントを識別するオブジェクト。ラベルを付けるかまたは特定した後で、1
つまたは複数のセグメントを組み合わせて連続データのマーカを作成します。

Optical ツールでは、マーカはセンサーの別名です。
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センサ (214 ページ)も参照してください。

マーカセット
モーションデータ(磁気マーカや光学式センサなど)を含むオブジェクトをアク
ターにマッピングする一組のマーカ。この関連付けはそのあとでアクターを動か
すために使われます。Viewer ウィンドウでは、マーカセットはアクターにア
タッチされた白いマーカの集まりとして表示されます。

マッチポーズ
キャラクタをポーズに従わせたいときに、Ragdoll ソルバでターゲットスタンス
として使用されるキャラクタポーズ。Viewer ウィンドウでは、マッチポーズは
赤い棒で表されます。

マッチポーズは、ガイドポーズよりも決定的なポーズです。ガイドポーズ(201
ページ)も参照してください。

マテリアル
マテリアルアセットは、モデルの色を変更したり、モデルのサーフェスがライ
トにどのように反応するかをシミュレートするプロパティのセットです。このプ
ロパティには、色、輝度、透明度、反射率、バンプなどが含まれます。最良の結
果を得るには、テクスチャおよびシェーダ付きのマテリアルを使用します。

密なデータ
多くのキーフレームとして表示されるアニメーション(モーションキャプチャ
データまたはプロットされたアニメーション)。

明度
コントラストと同様に、オブジェクトの輝度を定義するプロパティ。
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命名テンプレート
スケルトンの定義に使用される、カスタマイズされた命名規則を保存した .fbx
ファイルです。

モアレ
波状のパターン。

モーションキャプチャ
特殊なセンサまたはマーカを身につけたパフォーマの動作に基づいてモーション
データを収集する方法。

モーションソース
Character アセットを介してキャラクタモデルにリンクされた Actor、
Character、または Control Rig などのアセットで、キャラクタモデルの動きを
制御します。

モーフターゲット
シェイプを持ったアニメーションのあるモデルに対して使用できる操作。シェイ
プ操作とも呼ばれます。

モデル
シーン内に配置される 3D オブジェクトの数学的描写。
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や行

ユーザ座標系(UCS)
3D 空間における X、Y、Z 軸の方向を定義する、ユーザ定義の座標系。UCS に
よって、ジオメトリが描画されるデフォルトの位置が決まります。ワールド座標
系(WCS)も参照してください。

ワールド座標系(WCS) (232 ページ)も参照してください。

ユーザチャンネル
キャラクタフェイス設定で作成できるカスタムチャンネル。

チャンネル (216 ページ)およびキャラクタフェイス (205 ページ)も参照してくだ
さい。

ヨー
オブジェクトの中心を軸にしたオブジェクトの回転。たとえば、ターンテーブル
上のレコードなど。

ら行

ラベルなしセグメント
データのセグメントのうち、まだマーカと関連付けてラベルが付けられていない
セグメント。光学式クリーニング中に行われます。ラベルなしセグメントは、青
いアスタリスクで表示されます。

リジッドボディ
オクルージョンを補正するためにグループ化された 2 つ以上のマーカ。
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リターゲッティング
キャラクタにマッピングされているアニメーションデータを別のキャラクタに
適用することで、プロット(またはベイク)を行わずにアニメーションをコント
ロールすること。

リニアキー
キーのゲインが約 1 である輝度キーの効果。アンチエイリアスされたキャラク
タジェネレータとデジタルビデオ効果デバイスで作成された、キーソースエッ
ジの形状を保持します。

輝度キー (204 ページ)も参照してください。

リファレンスノード
モデル全体として動作するヌルまたはジョイントで、モデルのヒップの親です。

リモートポート
物理的に入出力装置を接続できる、シリアル装置によって供給される追加ポー
ト。

ループ
Transport Controls で Play をクリックしたときに、連続して再生するように指
定されたテイク領域。

レイヤ
オリジナルのファンクションカーブに重ねることのできる、シーン内のアニメー
ションシーンの階層。シーンには複数のレイヤを作成でき、他のレイヤに影響
を与えることなく任意のレイヤを変更できます。

BaseAnimation レイヤ (186 ページ) も参照してください。
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レストポーズ
Characte Face アセットが休止するときのデフォルト位置。

レンダリング
シーンを構成するオブジェクトを数学的に描画して、イメージファイル、一連
のイメージファイル(イメージシーケンス)、またはムービーファイルを生成す
ること。

ローカル座標
(X、Y、Z)形式で、選択したオブジェクトの基点に対する位置を定義する値。

グローバル座標(207ページ)、X 座標(196ページ)、Y 座標(196ページ)、Z 座標(
197 ページ)も参照してください。

ローカルブレンド
階層の一部だけである 1 つのトラック上の動作を、他のトラックの動作と置き
替える方法。

ロール
X 軸を軸にした回転。たとえば、丸太のローリングなど。

わ行

ワールド座標
ワールド座標系(WCS) (232 ページ)の座標。
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ワールド座標系(WCS)
すべてのオブジェクトおよび他の座標系を定義する際の基本となる座標系。

ユーザ座標系(UCS) (229 ページ)も参照してください。

ワイヤフレーム
ゴーストなどのオブジェクトを表示する方法。
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